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Updated Information

This vSphere Upgrade Guide is updated with each release of the product or when necessary.

This table provides the update history of the vSphere Upgrade Guide.

Revision Description

EN-000112-04 n Included a new topic, “DNS Requirements for vSphere,” on page 35 in System Requirements section.
n Modified the component values of Virtual Processor in “Requirements for Creating Virtual

Machines,” on page 34 section

EN-000112-03 Added cautionary wording to Chapter 11, “Upgrade to ESX 4.0 or ESXi 4.0,” on page 73
indicating that upgrades from ESX 3.x to ESX 4.x fail to replicate customized partitions.

EN-000112-02 Revised text in topics “Upgrade ESX Hosts,” on page 73 and “Upgrade ESXi Hosts,” on page 75to say
that the Host Update Utility can be used to upgrade ESX and ESXi hosts from version 3.x to version 4.0,
rather than to version 4.x, as previously stated.

EN-000112-01 n Renamed and clarified descriptions for various vCenter Server components in the section “vCenter
Server Upgrade Summary,” on page 37.

n Added a reference regarding rollup jobs in relationship to detaching and attaching the vCenter Server
database to a different Microsoft SQL Server in the section “Detach and Attach a Microsoft SQL Server
Database,” on page 50.

n Added a sentence to indicate that vSphere Host Update Utility does not support authenticated proxies.

EN-000112-00 Initial release.
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About This Book

The vSphere Upgrade Guide describes how to upgrade from earlier versions of VMware® ESX™, ESXi, and
VMware vCenter™ Server to ESX 4.0/ESXi 4.0 and vCenter Server 4.0.

This guide includes the following tasks:

n Upgrade to vCenter Server 4.0.

n Install vCenter Server 4.0 on a different machine and keep the VirtualCenter 2.x database. You would do
this if you are upgrading from a 32-bit server to a 64-bit server, for example.

n Upgrade to ESX 4.0 from ESX 3.x.

n Upgrade to ESXi 4.0 from ESXi 3.5.

n Upgrade to ESX 4.0 from ESX 2.5.x using upgrade VMotion.

n Upgrade to ESX 4.0 from ESX 2.5.x using cold migration.

n Change ESX to ESXi and the reverse.

n Upgrade VMware Tools and virtual hardware.

To learn how to simplify and automate your datacenter upgrade, see the vCenter Update Manager Administration
Guide.

If you have legacy versions of ESX, ESXi, and VirtualCenter, and you want to migrate to
VMware vsphere™ 4.0 by performing fresh installations that do not preserve existing data, see the following
manuals:

n ESX and vCenter Server Installation Guide

n ESXi Installable and vCenter Server Setup Guide

n ESXi Embedded and vCenter Server Setup Guide

Intended Audience
This book is intended for anyone who needs to upgrade from earlier versions of ESX/ESXi and vCenter Server
to ESX 4.0/ESXi 4.0 and vCenter Server 4.0. The information in this manual is written for experienced Microsoft
Windows or Linux system administrators who are familiar with virtual machine technology and datacenter
operations.

Document Feedback
VMware welcomes your suggestions for improving our documentation. If you have comments, send your
feedback to docfeedback@vmware.com.
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VMware vSphere Documentation
The vSphere documentation consists of the combined VMware vCenter Server and ESX/ESXi documentation
set.

Technical Support and Education Resources
The following technical support resources are available to you. To access the current version of this book and
other books, go to http://www.vmware.com/support/pubs.

Online and Telephone
Support

To use online support to submit technical support requests, view your product
and contract information, and register your products, go to 
http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support
for the fastest response on priority 1 issues. Go to 
http://www.vmware.com/support/phone_support.html.

Support Offerings To find out how VMware support offerings can help meet your business needs,
go to http://www.vmware.com/support/services.

VMware Professional
Services

VMware Education Services courses offer extensive hands-on labs, case study
examples, and course materials designed to be used as on-the-job reference
tools. Courses are available onsite, in the classroom, and live online. For onsite
pilot programs and implementation best practices, VMware Consulting
Services provides offerings to help you assess, plan, build, and manage your
virtual environment. To access information about education classes,
certification programs, and consulting services, go to 
http://www.vmware.com/services.
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Changes to the Upgrade Process 1
VMware vSphere introduces many changes to the upgrade process for vCenter Server and ESX/ESXi.

This chapter includes the following topics:

n “vCenter Server Upgrade,” on page 11

n “Host Upgrade,” on page 11

n “Datastore Upgrade,” on page 12

n “Virtual Machine Upgrade,” on page 12

n “Licensing,” on page 13

vCenter Server Upgrade
The process of upgrading VirtualCenter includes several changes from the upgrade process in previous
releases.

When you upgrade from VirtualCenter 2.x to vCenter Server 4.0, consider the following:

n The unified installer is no longer supported.

The autorun.exe executable file provides an HTML interface that presents the following installers:

n vCenter Server

n vCenter Guided Consolidation

n vSphere Client

n vCenter Update Manager

n vCenter Converter

n The database schema upgrade occurs before the upgrade to vCenter Server. This ensures that your existing
version of VirtualCenter 2.x remains in place until the database schema upgrade completes successfully.
When the database schema upgrade is successful, the upgrade to vCenter Server begins.

Host Upgrade
The process of upgrading ESX/ESXi hosts includes several changes from the upgrade process in previous
releases.

When you upgrade from ESX 3.x/ESXi 3.5 to ESX 4.0/ESXi 4.0, you can use either the vSphere Host Update
Utility or vCenter Update Manager.
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vSphere Host Update Utility
This tool is for upgrading ESX 3.x/ESXi 3.5 standalone hosts to ESX 4.0/ESXi 4.0 and for patching ESXi 4.0
standalone hosts. A standalone host is an ESX/ESXi host that is not managed in vCenter Server.

This utility is intended for small deployments with fewer than 10  ESX/ESXi hosts and without vCenter Server
or vCenter Update Manager. The utility includes a wizard that guides you through upgrades. While an upgrade
is in progress, the utility provides visual status.

vCenter Update Manager: Orchestrated Datacenter Upgrades
vCenter Update Manager is for upgrading ESX/ESXi hosts that are managed in vCenter Server.

With Update Manager 4.0, you can perform orchestrated upgrades of hosts and virtual machines. Orchestrated
upgrades allow you to upgrade all hosts in the inventory by using host upgrade baselines. You can use
orchestrated upgrades to upgrade the virtual hardware and VMware Tools of virtual machines in the inventory
at the same time, using baseline groups containing the following baselines:

n VM Hardware Upgrade to Match Host

n VMware Tools Upgrade to Match Host

Orchestrated upgrades can be performed at a cluster, folder or datacenter level.

This significantly simplifies the upgrade of hosts and virtual machines.

In addition, this tool enables you to configure policy-based compliance monitoring and remediation. For
example, you can define a host upgrade baseline to upgrade an ESX host to ESX 4.0, a virtual machine upgrade
baseline to upgrade the virtual machine hardware to the latest version, and VMware Tools to the latest version.
To do this, you use wizard-based workflows to first schedule host upgrades for an entire cluster and then
schedule a virtual machine upgrade for all the virtual machines.

Built-in best practices in the wizard workflows prevent erroneous upgrade sequences. For example, the wizard
prevents you from upgrading virtual machine hardware before you upgrade hosts in a cluster. vCenter Update
Manager monitors hosts and virtual machines for compliance against your defined upgrade baselines.
Noncompliance appears in detailed reports and in the dashboard view. vCenter Update Manager supports
mass remediation.

For detailed information about how to use vCenter Update Manager and how to orchestrate upgrades, see the
vCenter Update Manager Administration Guide.

Datastore Upgrade
No VMFS upgrade is required if you are upgrading from ESX 3.x/ESXi 3.5 with VMFS3 datastores.

Read-only VMFS2 support is deprecated in vSphere 4.0 and might be removed in future vSphere releases.

Virtual Machine Upgrade
Unlike previous releases, when you upgrade to vSphere 4.0, you must upgrade VMware Tools before
upgrading virtual hardware.

CAUTION   If you do not perform the upgrade in the correct order, your virtual machines might lose network
connectivity.

To ensure that the virtual machine upgrade happens in the correct order, you can use vCenter Update Manager
to automate the process. See the vCenter Update Manager Administration Guide.
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Licensing
Licensing is centralized in vCenter Server.

If you upgrade all your hosts, you no longer need a license server or host-based license files. All product licenses
are encapsulated in 25-character license keys that you can manage and monitor from vCenter Server.

Each host requires a license, and each vCenter Server instance requires a license. You cannot assign multiple
license keys to a host or to a vCenter Server system. You can license multiple hosts with one license key if the
key has enough capacity for more than one host. Likewise, you can license multiple vCenter Server instances
with one license key if the key has a capacity greater than one. When you apply a minor upgrade or patch the
ESX/ESXi or vCenter Server software, you do not need to replace the existing license key with a new one. If
you upgrade the edition of the license (for example, from standard to enterprise), you must replace the existing
license key in the inventory with a new upgraded license key.

On the VMware Web site, log in to your account page to access the license portal. From the license portal,
upgrade your legacy licenses. After you upgrade to vCenter Server and ESX 4.0/ESXi 4.0, use the vSphere Client
to assign the upgraded license keys to your assets.

Chapter 1 Changes to the Upgrade Process
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Example Upgrade Scenarios 2
Upgrade scenarios for vSphere 4.0 include cases with and without clustered hosts, hosts that you upgrade on
the same machine where they are currently running, and hosts that you upgrade using different machines.

This chapter includes the following topics:

n “About the Upgrade Process,” on page 15

n “Upgrading Environments with Host Clusters,” on page 16

n “Upgrading Environments Without Host Clusters,” on page 17

n “Upgrading by Moving Virtual Machines Using VMotion,” on page 18

n “Upgrading by Moving Virtual Machines Using Upgrade VMotion,” on page 20

n “Upgrading by Moving Powered Off or Suspended Virtual Machines (with vCenter Server),” on
page 22

n “Upgrading by Moving Powered Off or Suspended Virtual Machines (Without vCenter Server),” on
page 23

n “Upgrading to vCenter Server on a New Machine,” on page 24

About the Upgrade Process
Upgrading is a multistage process in which procedures must be performed in a particular order. If you follow
the suggested process, you can help ensure a smooth upgrade with a minimum of system downtime.

CAUTION   VMware recommends that you read about the upgrade process before attempting to upgrade. If you
do not follow appropriate safeguards, you might lose data and lose access to your servers. Without careful
planning, you might incur more downtime than is necessary.

You must complete the upgrade process in a specific order. If you do not complete each upgrade stage before
moving on, you can lose data and server access. Order is also important within each upgrade stage.

Generally, you can perform the upgrade process for each component in only one direction. For example, after
you upgrade to vCenter Server, you cannot revert to VirtualCenter 2.x. With appropriate backups and
planning, you can restore your original software records.

You can take any amount of time to complete each of the upgrade procedures. However, keep in mind the
following considerations:

n You must complete one procedure before you move to the next procedure.

n Some major procedures include minor substeps. Follow the directions within each procedure regarding
the required sequence of minor substeps.
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Because certain commands can simultaneously upgrade more than one stage, VMware recommends that you
thoroughly understand the irreversible changes at each stage before you upgrade your production
environments.

To ensure that your datacenter upgrade goes smoothly, you can use vCenter Update Manager to manage the
process for you.

Upgrading Environments with Host Clusters
This example scenario shows how you can use vCenter Update Manager to simplify the host and virtual
machine upgrade process and minimize downtime in environments that include host clusters.

These are the prerequisites for this scenario:

n You must have VirtualCenter 2.x.

n You must have vCenter Update Manager.

n All your hosts must be ESX 3.x/ESXi 3.5.

The following list of tasks provides a high-level overview of the upgrade process.

1 Upgrade VirtualCenter 2.x to vCenter Server 4.0.

a Make sure your database is compatible with vCenter Server 4.0. This release discontinues support for
some database versions and adds support for other database versions. See the Compatibility
Matrixes on the VMware vSphere documentation Web site.

b Make sure that you have the required permissions to perform this procedure. See “Database
Prerequisites,” on page 39.

c Take a full backup of the VirtualCenter 2.x database. See your database documentation.

d Back up the VirtualCenter 2.x SSL certificates. See “Back Up VirtualCenter 2.x,” on page 43.

The downtime required for this upgrade is based on the amount of data in the database. During this time,
you cannot perform provisioning operations, such as cloning or creating virtual machines. The upgrade
from VirtualCenter 2.5 is faster in comparison to the upgrade from VirtualCenter 2.0.x because of
differences in changes to the database schema and the amount of data migration.

After the upgrade, the ESX hosts are automatically reconnected to vCenter Server 4.0. Your VMware High
Availability (HA) and VMware Distributed Resource Scheduler (DRS) clusters are automatically
reconfigured. (Check to ensure that the automatic reconfiguration is successful. In some cases, you might
need to reconfigure the clusters manually.)

For a detailed description of the upgrade procedure, see Chapter 5, “Preparing for the Upgrade to vCenter
Server,” on page 37 and Chapter 6, “Upgrading to vCenter Server 4.0,” on page 45.

2 Install the vSphere Client.

You can install the vSphere Client on the same machine with your previous version of the VI Client. You
must have the previous version of the VI Client to connect to previous versions of VirtualCenter and
ESX/ESXi.

For a detailed description of the procedure, see “Upgrade to the vSphere Client,” on page 56.

3 If your environment has vCenter Converter, upgrade it to the latest version.

4 If your environment has vCenter Guided Consolidation, complete the consolidation plan and then
upgrade it to the latest version.

5 Upgrade to vCenter Update Manager 4.0.

6 Use vCenter Update Manager to upgrade ESX 3.x hosts to ESX 4.0.
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vCenter Update Manager puts the host into maintenance mode before upgrading the host. The downtime
for the procedure depends on the network speed and the server boot time.

In case of upgrade failure, vCenter Update Manager supports rollback to the previous release.

For a detailed description of the procedure, see the vCenter Update Manager Administration Guide.

7 Use vCenter Update Manager to upgrade your virtual machines. vCenter Update Manager ensures that
the VMware Tools upgrade and the virtual hardware upgrade happen in the correct order to prevent loss
of your network connectivity. vCenter Update Manager also performs automatic backups of your virtual
machines in case you need to roll back after the upgrade. You can upgrade clusters without powering off
the virtual machines if Distributed Resource Scheduler is available for the cluster.

8 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using vCenter Server.

Upgrading Environments Without Host Clusters
If you have standalone ESX 3.x/ESXi 3.5 hosts, you can use vSphere Host Update Utility to upgrade your hosts
and the vSphere Client to upgrade your virtual machines.

This scenario assumes that you do not have host clusters and you do not have vCenter Update Manager. In
such a case, you probably do not have VirtualCenter either. If you do have VirtualCenter, the following process
can apply to your environment as well.

The following list of tasks provides a high-level overview of the upgrade process.

1 If you have VirtualCenter, upgrade VirtualCenter 2.x to vCenter Server 4.0.

a Make sure your database is compatible with vCenter Server 4.0. This release discontinues support for
some database versions and adds support for other database versions. See the Compatibility
Matrixes on the VMware vSphere documentation Web site.

b Make sure that you have the required permissions to perform this procedure. See “Database
Prerequisites,” on page 39.

c Take a full backup of the VirtualCenter 2.x database. See your database documentation.

d Back up the VirtualCenter 2.x SSL certificates. See “Back Up VirtualCenter 2.x,” on page 43.

The downtime required for this upgrade is based on the amount of data in the database. During this time,
you cannot perform provisioning operations, such as cloning or creating virtual machines. The upgrade
from VirtualCenter 2.5 is faster in comparison to the upgrade from VirtualCenter 2.0.x because of
differences in changes to the database schema and the amount of data migration.

After the upgrade, the ESX hosts are automatically reconnected to vCenter Server 4.0.

For a detailed description of the upgrade procedure, see Chapter 5, “Preparing for the Upgrade to vCenter
Server,” on page 37 and Chapter 6, “Upgrading to vCenter Server 4.0,” on page 45.

2 Install the vSphere Client.

You can install the vSphere Client on the same machine with your previous version of the VI Client. You
must have the previous version of the VI Client to connect to previous versions of VirtualCenter and
ESX/ESXi.

During vSphere Client installation, install the vSphere Host Update Utility. By default, this utility is not
installed. Install it if you plan to use this Windows machine to initiate host upgrades.

For a detailed description of the procedure, see “Upgrade to the vSphere Client,” on page 56.

3 If your environment has vCenter Converter, upgrade it.

Chapter 2 Example Upgrade Scenarios
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4 If your environment has vCenter Guided Consolidation, complete the consolidation plan and then
upgrade it to the latest version.

5 Use vSphere Host Update Utility to upgrade ESX 3.x/ESXi 3.5 hosts to ESX 4.0.

This procedure involves putting the host into maintenance mode before you upgrade the host. The
downtime for the procedure depends on the network speed and the server boot time.

In case of upgrade failure, the process supports rollback to the previous release.

For a detailed description of the procedure, see Chapter 11, “Upgrade to ESX 4.0 or ESXi 4.0,” on
page 73.

6 Use the vSphere Client to upgrade your virtual machines:

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.0.

b Power off the virtual machines and upgrade to the latest version of virtual hardware to take advantage
of the new virtual hardware.

The virtual machine upgrade process has changed in this release. In earlier releases, the virtual hardware
upgrade came before the VMware Tools upgrade. For this release, you must upgrade the VMware Tools
before you upgrade the virtual hardware.

7 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each ESX/ESXi host and the virtual machines on the hosts.

Upgrading by Moving Virtual Machines Using VMotion
This scenario is known as a migration upgrade. The migration upgrade is a managed transition rather than a
strict upgrade. By using VMotion to move virtual machines directly from one production host to another
production host, you minimize downtime of the virtual machines.

The following example provides a high-level overview of the upgrade process in an environment with
ESX 3.x/ESXi 3.5 and VirtualCenter 2.x, using VMotion to migrate your running virtual machines to
ESX 4.0/ESXi 4.0. The hosts in your environment must be licensed for and able to use VMotion.

You can perform a migration upgrade without VMotion. The only difference is the amount of downtime for
the virtual machines.

The disadvantage of a migration upgrade is that this plan requires additional resources. A migration upgrade
calls for sufficient resources to run the production environment partly on older hosts and partly on upgraded
hosts. Any required redundancies and safeguards must be available on both upgraded and non-upgraded
infrastructure during the transition.

Prerequisites

The requirements for a migration upgrade with VMotion are as follows:

n One or more machines meeting ESX 4.0/ESXi 4.0 requirements.

n Empty host storage sufficient to hold a portion of your production virtual machines. Ideally, the storage
should be large enough to hold all of the migrated virtual machines. A larger capacity for virtual machines
on this extra storage means fewer operations are required before all your virtual machines are migrated.

vSphere Upgrade Guide
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Before you begin this procedure, complete the following tasks:

1 Upgrade VirtualCenter 2.x to vCenter Server 4.0.

a Make sure your database is compatible with vCenter Server 4.0. This release discontinues support for
some database versions and adds support for other database versions. See the Compatibility
Matrixes on the VMware vSphere documentation Web site.

b Make sure that you have the required permissions to perform this procedure. See “Database
Prerequisites,” on page 39.

c Take a full backup of the VirtualCenter 2.x database. See your database documentation.

d Back up the VirtualCenter 2.x SSL certificates. See “Back Up VirtualCenter 2.x,” on page 43.

The downtime required for this upgrade is based on the amount of data in the database. During this time,
you cannot perform provisioning operations, such as cloning or creating virtual machines. The upgrade
from VirtualCenter 2.5 is faster in comparison to the upgrade from VirtualCenter 2.0.x because of
differences in changes to the database schema and the amount of data migration.

After the upgrade, the ESX hosts are automatically reconnected to vCenter Server 4.0. Your VMware High
Availability (HA) and VMware Distributed Resource Scheduler (DRS) clusters are automatically
reconfigured. (Check to ensure that the automatic reconfiguration is successful. In some cases, you might
need to reconfigure the clusters manually.)

For a detailed description of the upgrade procedure, see Chapter 5, “Preparing for the Upgrade to vCenter
Server,” on page 37 and Chapter 6, “Upgrading to vCenter Server 4.0,” on page 45.

2 Install the vSphere Client.

You can install the vSphere Client on the same machine with your previous version of the VI Client. You
must have the previous version of the VI Client to connect to previous versions of VirtualCenter and
ESX/ESXi.

For a detailed description of the procedure, see “Upgrade to the vSphere Client,” on page 56.

3 If your environment has vCenter Converter, upgrade it to the latest version.

4 If your environment has vCenter Guided Consolidation, complete the consolidation plan and then
upgrade it to the latest version.

5 If your environment has vCenter Update Manager, upgrade it to the latest version.

Procedure

1 Use VMotion to evacuate the virtual machines from the ESX 3.x/ESXi 3.5 hosts.

2 Upgrade to ESX 4.0/ESXi 4.0, or perform a fresh installation of ESX 4.0/ESXi 4.0.

3 Add the ESX 4.0/ESXi 4.0 host to vCenter Server.

For VMotion to work, the ESX 3.x/ESXi 3.5 and ESX 4.0/ESXi 4.0 hosts must be managed by the same
vCenter Server instance.

4 Use VMotion to move virtual machine to the ESX 4.0/ESXi 4.0 host.

What to do next

1 Upgrade your virtual machines:

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.0./ESXi 4.0.

b Power off the virtual machines and upgrade to the latest version of virtual hardware to take advantage
of the new virtual hardware. vSphere 4.0 supports some earlier virtual hardware versions. See Basic
System Administration.

Chapter 2 Example Upgrade Scenarios
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The virtual machine upgrade process is different for ESX 4.0/ESXi 4.0. In earlier versions, you upgraded
the virtual hardware upgrade before you upgraded VMware Tools. For ESX 4.0/ESXi 4.0, you upgrade
VMware Tools before you upgrade the virtual hardware.

You can use either the vSphere Client or vCenter Update Manager to upgrade virtual machines. In a
clustered environment, VMware recommends that you use vCenter Update Manager . See the vCenter
Update Manager Administration Guide. If you are using the vSphere Client to upgrade virtual machines, see
Chapter 13, “Upgrading Virtual Machines,” on page 83.

2 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each ESX 2.5.x host and the virtual machines on the hosts.

Upgrading by Moving Virtual Machines Using Upgrade VMotion
This scenario is known as a migration upgrade that includes datastore migration. The migration upgrade is a
managed transition rather than a strict upgrade. By using VMotion to move virtual machines directly from
one datastore to another datastore, you minimize downtime of the virtual machines.

The following example provides a high-level overview of the upgrade process in an environment with ESX 2.5.x
and VirtualCenter 1.4.x, using upgrade VMotion to migrate your running virtual machines to ESX 4.0. The
hosts in your environment must be licensed for and able to use VMotion.

You can perform a migration upgrade without VMotion. The only difference is the amount of downtime for
the virtual machines.

Upgrade VMotion (also known as VMotion with datastore relocation) is a special case in which you perform
a one-way VMotion. In this scenario, you move virtual disks from a VMFS 2 volume to a VMFS 3 volume.
Requirements include persistent-mode disks, a VMFS 2 volume that is visible to the ESX 4.0 host, and
compatible host CPUs.

NOTE   Upgrade VMotion is required if you have ESX 2.5.x hosts.

The disadvantage of a migration upgrade is that this plan requires additional resources. A migration upgrade
calls for sufficient resources to run the production environment partly on older hosts and partly on upgraded
hosts. Any required redundancies and safeguards must be available on both upgraded and non-upgraded
infrastructure during the transition.

Prerequisites

The requirements for upgrade VMotion are as follows:

n One or more machines meeting ESX 4.0/ESXi 4.0 requirements.

n Empty host storage sufficient to hold a portion of your production virtual machines. Ideally, the storage
should be large enough to hold all of the migrated virtual machines. A larger capacity for virtual machines
on this extra storage means fewer operations are required before all your virtual machines are migrated.

Before you begin this procedure, complete the following tasks:

1 Install vCenter Server 4.0. You cannot upgrade VirtualCenter 1.4.x to vCenter Server 4.0. You must perform
a fresh installation.

For the supported operating systems, database types, and other prerequisites, see the Compatibility
Matrixes and the Installation Guide on the VMware vSphere documentation Web site.

2 Install the vSphere Client 4.0.

vSphere Upgrade Guide

20  VMware, Inc.



You can install the vSphere Client on the same machine with your previous version of the VI Client. You
must have the previous version of the VI Client to connect to previous versions of VirtualCenter and
ESX/ESXi.

For the supported operating systems and other prerequisites, see the Compatibility Matrixes and the
Installation Guide.

Procedure

1 Install ESX 4.0/ESXi 4.0.

2 Create a VMFS3 datastore with a capacity that is greater than or equal to the VMFS2 datastore on the
ESX 2.5.x host.

3 Add the ESX 4.0/ESXi 4.0 host to vCenter Server.

4 Remove the ESX 2.5.x host from VirtualCenter 1.4.x and add it to vCenter Server 4.0.

For upgrade VMotion to work, the ESX 2.5.x and ESX 4.0/ESXi 4.0 hosts must be managed by the same
vCenter Server.

5 Expose the VMFS2 volume to the ESX 4.0/ESXi 4.0 host.

Upgrade VMotion requires that both the VMFS2 and VMFS3 volume are visible to the ESX 4.0 host. VMFS2
volumes are read-only on ESX 4.0/ESXi 4.0 hosts.

6 Select a powered on virtual machine and migrate it.

Upgrade VMotion copies the disk from VMFS2 to VMFS3. This process takes a varying amount of time,
depending on the size of the disk and the IO load.

The hardware version of the virtual machines is automatically upgraded from version 3 to version 4.

What to do next

1 Optionally, upgrade the virtual machines further.

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.0./ESXi 4.0.

b Power off the virtual machines and upgrade to the latest version of virtual hardware (version 7) to
take advantage of the new virtual hardware. vSphere 4.0 supports some earlier virtual hardware
versions. See Basic System Administration.

The virtual machine upgrade process is different for ESX 4.0/ESXi 4.0. In earlier versions, you upgraded
the virtual hardware upgrade before you upgraded VMware Tools. For ESX 4.0/ESXi 4.0, you upgrade
VMware Tools before you upgrade the virtual hardware.

You can use either the vSphere Client or vCenter Update Manager to upgrade virtual machines. In a
clustered environment, VMware recommends that you use vCenter Update Manager . See the vCenter
Update Manager Administration Guide. If you are using the vSphere Client to upgrade virtual machines, see
Chapter 13, “Upgrading Virtual Machines,” on page 83.

2 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each ESX 2.5.x host and the virtual machines on the hosts.
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Upgrading by Moving Powered Off or Suspended Virtual Machines
(with vCenter Server)

This scenario is known as a cold migration upgrade. When you use cold migration to move virtual machines
from one host to another host, additional downtime is required for the virtual machines.

This scenario assumes that the hosts do not have VMotion.

Prerequisites

The requirements for a cold migration upgrade are as follows:

n One or more machines meeting ESX 4.0/ESXi 4.0 requirements.

n Empty host storage sufficient to hold a portion of your virtual machines. Ideally, the storage should be
large enough to hold all of the migrated virtual machines. A larger capacity for virtual machines on this
extra storage means fewer operations are required before all your virtual machines are migrated.

Before you begin this procedure, complete the following tasks:

1 Upgrade VirtualCenter 2.x to vCenter Server 4.0.

a Make sure your database is compatible with vCenter Server 4.0. This release discontinues support for
some database versions and adds support for other database versions. See the Compatibility
Matrixes on the VMware vSphere documentation Web site.

b Make sure that you have the required permissions to perform this procedure. See “Database
Prerequisites,” on page 39.

c Take a full backup of the VirtualCenter 2.x database. See your database documentation.

d Back up the VirtualCenter 2.x SSL certificates. See “Back Up VirtualCenter 2.x,” on page 43.

The downtime required for this upgrade is based on the amount of data in the database. During this time,
you cannot perform provisioning operations, such as cloning or creating virtual machines. The upgrade
from VirtualCenter 2.5 is faster in comparison to the upgrade from VirtualCenter 2.0.x because of
differences in changes to the database schema and the amount of data migration.

After the upgrade, the ESX hosts are automatically reconnected to vCenter Server 4.0. Your VMware High
Availability (HA) and VMware Distributed Resource Scheduler (DRS) clusters are automatically
reconfigured. (Check to ensure that the automatic reconfiguration is successful. In some cases, you might
need to reconfigure the clusters manually.)

For a detailed description of the upgrade procedure, see Chapter 5, “Preparing for the Upgrade to vCenter
Server,” on page 37 and Chapter 6, “Upgrading to vCenter Server 4.0,” on page 45.

2 Install the vSphere Client.

You can install the vSphere Client on the same machine with your previous version of the VI Client. You
must have the previous version of the VI Client to connect to previous versions of VirtualCenter and
ESX/ESXi.

For a detailed description of the procedure, see “Upgrade to the vSphere Client,” on page 56.

3 If your environment has vCenter Converter, upgrade it to the latest version.

4 If your environment has vCenter Guided Consolidation, complete the consolidation plan and then
upgrade it to the latest version.

5 If your environment has vCenter Update Manager, upgrade it to the latest version.

Procedure

1 Add ESX 4.0/ESXi 4.0 host to vCenter Server 4.0.
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2 Add ESX 2.5.x or ESX 3.x/ESXi 3.5 hosts to vCenter Server 4.0.

3 Power off or suspend the virtual machines on the ESX 2.5.x or ESX 3.x/ESXi 3.5 hosts.

4 Move the virtual machines to the ESX 4.0/ESXi 4.0 hosts.

What to do next

1 Upgrade your virtual machines:

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.0./ESXi 4.0.

b Power off the virtual machines and upgrade to the latest version of virtual hardware to take advantage
of the new virtual hardware. vSphere 4.0 supports some earlier virtual hardware versions. See Basic
System Administration.

The virtual machine upgrade process is different for ESX 4.0/ESXi 4.0. In earlier versions, you upgraded
the virtual hardware upgrade before you upgraded VMware Tools. For ESX 4.0/ESXi 4.0, you upgrade
VMware Tools before you upgrade the virtual hardware.

You can use either the vSphere Client or vCenter Update Manager to upgrade virtual machines. In a
clustered environment, VMware recommends that you use vCenter Update Manager . See the vCenter
Update Manager Administration Guide. If you are using the vSphere Client to upgrade virtual machines, see
Chapter 13, “Upgrading Virtual Machines,” on page 83.

2 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each ESX 2.5.x host and the virtual machines on the hosts.

Upgrading by Moving Powered Off or Suspended Virtual Machines
(Without vCenter Server)

This scenario is known as a cold migration upgrade. When you use cold migration to move virtual machines
from one host to another host, additional downtime is required for the virtual machines.

This scenario assumes that the hosts do not have VMotion, VirtualCenter, or vCenter Server.

Prerequisites

The requirements for a cold migration upgrade are as follows:

n One or more machines meeting ESX 4.0/ESXi 4.0 requirements.

n Empty host storage sufficient to hold a portion of your virtual machines. Ideally, the storage should be
large enough to hold all of the migrated virtual machines. A larger capacity for virtual machines on this
extra storage means fewer operations are required before all your virtual machines are migrated.

Before you begin this procedure, install the vSphere Client. You can install the vSphere Client on the same
machine with your previous version of the VI Client. You must have the previous version of the VI Client to
connect to previous versions of VirtualCenter and ESX/ESXi. For a detailed description of the procedure, see 
“Upgrade to the vSphere Client,” on page 56.

Procedure

1 Power off or suspend the virtual machines on the ESX 2.5.x or ESX 3.x/ESXi 3.5 host.

IMPORTANT   For suspended virtual machine migrations, both hosts must have identical processors.

2 Evacuate the virtual machines from the host by moving the virtual machines to other hosts.

Chapter 2 Example Upgrade Scenarios

VMware, Inc.  23



3 Upgrade ESX 3.x/ESXi 3.5 to ESX 4.0, or perform a fresh installation of ESX 4.0. A fresh installation is
required if your legacy hosts are ESX 2.5.x.

4 (Optional) Create a VMFS3 datastore.

5 Move the virtual machines to ESX 4.0 host.

What to do next

1 Upgrade your virtual machines:

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.0./ESXi 4.0.

b Power off the virtual machines and upgrade to the latest version of virtual hardware to take advantage
of the new virtual hardware. vSphere 4.0 supports some earlier virtual hardware versions. See Basic
System Administration.

The virtual machine upgrade process is different for ESX 4.0/ESXi 4.0. In earlier versions, you upgraded
the virtual hardware upgrade before you upgraded VMware Tools. For ESX 4.0/ESXi 4.0, you upgrade
VMware Tools before you upgrade the virtual hardware.

You can use either the vSphere Client or vCenter Update Manager to upgrade virtual machines. In a
clustered environment, VMware recommends that you use vCenter Update Manager . See the vCenter
Update Manager Administration Guide. If you are using the vSphere Client to upgrade virtual machines, see
Chapter 13, “Upgrading Virtual Machines,” on page 83.

2 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each ESX 2.5.x host and the virtual machines on the hosts.

Upgrading to vCenter Server on a New Machine
Instead of performing an in-place upgrade to vCenter Server, you might want to use a different machine for
your upgrade.

One common reason for doing this is to upgrade to a 64-bit platform. When you upgrade to vCenter Server on
a new machine, you can keep your existing database where it is or move it. You might want to move your
database to keep the database local to the vCenter Server machine.

Following is an overview of the process:

n Create a backup of the database.

n Optionally, move the database by performing one of the following procedures:

n Restore the database on the destination machine.

n Detach the database from the source machine and attach it to the destination machine.

n Copy the SSL folder onto the destination machine.

n Run the vCenter Server installer on the destination machine.

This process is described in detail in Chapter 7, “Upgrading to vCenter Server on a Different Machine and
Keeping the Existing Database,” on page 49.

vSphere Upgrade Guide

24  VMware, Inc.



Changing Host Types 3
Changing host types from ESX to ESXi (or ESXi to ESX) have no in-place upgrade, but you can migrate existing
virtual machines and datastores or perform an in-place, fresh installation to replace one host type with another.

This chapter includes the following topics:

n “Change ESX to ESXi Installable,” on page 25

n “Change ESXi Embedded to ESX,” on page 25

n “Change ESXi Embedded to ESXi Installable,” on page 26

Change ESX to ESXi Installable
You might choose to replace ESX with ESXi Installable. The method you use for performing this task depends
on whether you need to preserve VMFS datastores.

If you install ESXi Installable on the same disk where ESX is installed, ESXi overwrites the VMFS datastores
on the disk. To prevent this, you can migrate virtual machines from an ESX host to an ESXi host.

Procedure

1 Choose a method to replace ESX with ESXi.

n If you do not want to preserve the virtual machines on the datastore, install ESXi on the disk on which
ESX is installed.

ESXi writes over ESX.

See the Setup Guide.

n If you do want to preserve the virtual machines on the datastore, migrate virtual machines from an
ESX host to an ESXi host .

See Basic System Administration.

2 Use the vSphere Client to reregister the virtual machines on the ESXi host.

See Basic System Administration.

Change ESXi Embedded to ESX
You might choose to replace ESXi Embedded with ESX.

Prerequisites

You must have an ESXi Embedded host. An ESXi Embedded host is a physical server that contains an ESX
image preinstalled as firmware in the factory or burned onto an external USB key.
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Procedure

1 Choose a method to replace ESXi Embedded with ESX.

n If you do not want to preserve the virtual machines on the datastore, disable ESXi Embedded and
install ESX. See the ESXi Embedded Setup Guide and the ESX Installation Guide.

n If you do want to preserve the virtual machines on the datastore, migrate virtual machines from an
ESXi host to an ESX host. See Basic System Administration.

2 Reregister the virtual machines with the ESX host by using vSphere Client.

See Basic System Administration.

Change ESXi Embedded to ESXi Installable
You might choose to replace ESXi Embedded with ESXi Installable. ESXi Installable is a physical server that
contains an ESX image installed on a local hard drive.

IMPORTANT   ESXi Installable and ESXi Embedded can exist on the same host. However, having them on the
same host causes ESXi upgrades to fail, so coexistence is not supported.

CAUTION   Overwriting the ESXi Embedded image might cause you to lose drivers installed by your hardware
vendor.

Prerequisites

You must have an ESXi Embedded host. An ESXi Embedded host is a physical server that contains an ESX
image preinstalled as firmware in the factory or burned onto an external USB key.

Procedure

1 Install ESXi Installable on the machine's hard disk.

2 Copy virtual machines from the ESXi Embedded VMFS datastore to the ESXi Installable VMFS datastore.

3 Reboot the machine and configure the boot setting to boot from the hard disk where you installed ESXi
rather than the USB disk.

4 If you can remove the ESXi Embedded USB device, remove it. If the USB device is internal, clear or
overwrite the USB partitions.

Removing or overwriting ESXi Embedded is required so that the ESXi host can be upgraded in the future.
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System Requirements 4
Hosts running vCenter Server and ESX must meet specific hardware and operating system requirements.

This chapter includes the following topics:

n “ESX Hardware Requirements,” on page 27

n “ESXi Hardware Requirements,” on page 30

n “vCenter Server and the vSphere Client Hardware Requirements,” on page 32

n “vCenter Server Software Requirements,” on page 33

n “vSphere Client Software Requirements,” on page 34

n “Support for 64-Bit Guest Operating Systems,” on page 34

n “Requirements for Creating Virtual Machines,” on page 34

n “Required Ports,” on page 34

n “DNS Requirements for vSphere,” on page 35

n “Supported Remote Management Firmware Versions,” on page 36

ESX Hardware Requirements
Using ESX requires specific hardware and system resources.

64-Bit Processor
n VMware ESX 4.0 will only install and run on servers with 64-bit x86 CPUs.

n Known 64-bit processors:

n All AMD Opterons support 64 bit.

n All Intel Xeon 3000/3200, 3100/3300, 5100/5300, 5200/5400, 7100/7300, and 7200/7400 support 64 bit.

n All Intel Nehalem (no Xeon brand number assigned yet) support 64 bit.

RAM
2GB RAM minimum

Network Adapters
One or more network adapters. Supported network adapters include:

n Broadcom NetXtreme 570x gigabit controllers

VMware, Inc.  27



n Intel PRO 1000 adapters

SCSI Adapter, Fibre Channel Adapter, or Internal RAID Controller
One or more of the following controllers (any combination can be used):

n Basic SCSI controllers are Adaptec Ultra-160 and Ultra-320, LSI Logic Fusion-MPT, and most
NCR/Symbios SCSI controllers.

n Fibre Channel, see the Hardware Compatibility Guide at http://www.vmware.com/resources/compatibility.

n RAID adapters supported are HP Smart Array, Dell Perc (Adaptec RAID and LSI MegaRAID), and IBM
(Adaptec) ServeRAID controllers.

Installation and Storage
n SCSI disk, Fibre Channel LUN, or RAID LUN with unpartitioned space. In a minimum configuration, this

disk or RAID is shared between the service console and the virtual machines.

n For hardware iSCSI, a disk attached to an iSCSI controller, such as the QLogic qla405x. Software iSCSI is
not supported for booting or installing ESX.

n Serial attached SCSI (SAS).

n For Serial ATA (SATA), a disk connected through supported SAS controllers or supported on-board SATA
controllers. SATA disk drives connected behind supported SAS controllers or supported on-board SATA
controllers.

n Supported SAS controllers include:

n LSI1068E (LSISAS3442E)

n LSI1068 (SAS 5)

n IBM ServeRAID 8K SAS controller

n Smart Array P400/256 controller

n Dell PERC 5.0.1 controller

n Supported on-board SATA controllers include:

n Intel ICH9

n Nvidia MCP55

n ServerWorks HT1000

When installing ESX on SATA drives, consider the following:

n Ensure that your SATA drives are connected through supported SAS controllers or supported onboard
SATA controllers.

n NOTE ESXi does not support using local, internal SATA drives on the host server to create VMFS
datastores that are shared across multiple ESXi hosts.

ATA and IDE disk drives – ESX supports installing and booting on either an ATA drive or ATA RAID is
supported, but ensure that your specific drive controller is included in the supported hardware. IDE drives
are supported for ESX installation and VMFS creation.
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Recommendations for Enhanced ESX Performance
There are several things you can do to enhance ESX performance, including using multiple physical disks,
such as SCSI disks, Fibre Channel LUNs, and RAID LUNs.

Following are some recommendations for enhanced performance:

n RAM – The ESX host might require more RAM for the service console if you are running third-party
management applications or backup agents.

n Network adapters for virtual machines – Dedicated Gigabit Ethernet cards for virtual machines, such as
Intel PRO 1000 adapters, improve throughput to virtual machines with high network traffic.

n Disk location – For best performance, store all data used by your virtual machines on physical disks
allocated to virtual machines. These physical disks should be large enough to hold disk images used by
all the virtual machines.

n Processors – Faster processors improve ESX performance. For certain workloads, larger caches improve
ESX performance.

n Hardware compatibility – Use devices in your server that are supported by ESX 4.0 drivers. See the
Hardware Compatibility Guide at http://www.vmware.com/resources/compatibility.

Tested Software and Firmware for Creating ESX Installation Media
Before you install ESX, you might need to burn the ESX installation ISO image onto DVD or USB media. Review
the firmware and software that VMware has tested and has confirmed works.

VMware has tested these combinations, however, other combinations might work as well.

Table 4-1 lists the tested combinations for burning the ESX installation ISO image onto DVD media.

Table 4-1.  Tested Combinations for DVD

DVD Drive (Make, Model, and BIOS) Software to Burn DVD DVD Media

Phillips + RW DVD8801 Roxio Creator Classic version: 6.1.1.48 SONY DVD +RW 120min / 4.7 GB

Philips PLDS DVD + RW DH-16A6S Roxio Creator version: 3.3.0 SONY DVD+RW

Philips PLDS DVD + RW DH-16W1S Roxio Creator version: 3.3.0 SONY DVD+RW

Philips BenQ PBDS + RW DH-16W1S Roxio Creator version: 3.3.0 SONY DVD+RW

HL-DT-ST DVD+-RW GSA-H53N Burn4Free V.4.6.0.0 SONY DVD+RW

Dell/_NEC DVD +-RW ND-3530A Roxio Creator Classic version: 6.1.1.48 Memorex DVD-R

Dell/_NEC DVD +-RW ND-3530A Roxio Creator Classic version: 6.1.1.48 Office Depot DVD+RW

Dell/_NEC DVD +-RW ND-3530A Roxio Creator Classic version: 6.1.1.48 Ativa DVD-RW

Dell/_NEC DVD +-RW ND-3530A Roxio Creator Classic version: 6.1.1.48 TDK DVD+R
Verbatim DVD+R
SONY DVD-R
Maxell DVD+R

Table 4-2 lists the tested combinations for burning the ESX installation ISO image onto USB media.

Table 4-2.  Tested Combinations for USB

External USB DVD Drive Firmware Version

Iomega Rev: XY13

LaCie Rev: LA00
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Table 4-2.  Tested Combinations for USB (Continued)

External USB DVD Drive Firmware Version

LG 8x portable DVD Rewriter Rev: KE01

SONY DVD+- R 20X Rev: SS01

ESXi Hardware Requirements
Make sure the host meets the minimum hardware configurations supported by ESXi 4.0.

You need the following hardware and system resources to install and use ESXi 4.0:

n Supported server platform (for a list of supported platforms, see the Systems Compatibility Guide)

n VMware ESXi 4.0 will only install and run on servers with 64-bit x86 CPUs.

n Known 64-bit processors:

n All AMD Opterons support 64 bit.

n All Intel Xeon 3000/3200, 3100/3300, 5100/5300, 5200/5400, 7100/7300, and 7200/7400 support 64 bit.

n All Intel Nehalem (no Xeon brand number assigned yet) support 64 bit.

n 2GB RAM minimum

n One or more Gigabit or 10Gb Ethernet controllers. For a list of supported network adapter models, see the
Hardware Compatibility Guide at http://www.vmware.com/resources/compatibility.

n One or more of the following controllers (any combination can be used):

n Basic SCSI controllers – Adaptec Ultra-160 or Ultra-320, LSI Logic Fusion-MPT, or most NCR/Symbios
SCSI.

n RAID controllers – Dell PERC (Adaptec RAID or LSI MegaRAID), HP Smart Array RAID, or IBM
(Adaptec) ServeRAID controllers.

n SCSI disk or a local (non-network) RAID LUN with unpartitioned space for the virtual machines.

n For Serial ATA (SATA), a disk connected through supported SAS controllers or supported on-board SATA
controllers.

NOTE   You cannot connect a SATA CD-ROM device to a virtual machine on an ESXi 4.0 host. To use the
SATA CD-ROM device, you must use IDE emulation mode.

ESXi 4.0 Installable supports installing on and booting from the following storage systems:

n SATA disk drives – SATA disk drives connected behind supported SAS controllers or supported on-board
SATA controllers.

Supported SAS controllers include:

n LSI1068E (LSISAS3442E)

n LSI1068 (SAS 5)

n IBM ServeRAID 8K SAS controller

n Smart Array P400/256 controller

n Dell PERC 5.0.1 controller

Supported on-board SATA include:

n Intel ICH9

n Nvidia MCP55

vSphere Upgrade Guide

30  VMware, Inc.

http://www.vmware.com/resources/compatibility


n ServerWorks HT1000

NOTE   ESXi does not support using local, internal SATA drives on the host server to create VMFS datastores
that are shared across multiple ESXi hosts.

n Serial Attached SCSI (SAS) disk drives – Supported for installing ESXi 4.0 and for storing virtual machines
on VMFS partitions.

n USB devices – Supported for installing ESXi 4.0. For more information, refer KB 1010574 at 
http://kb.vmware.com/kb/1010574.

Recommendation for Enhanced ESXi Performance
To enhance performance, VMware recommends that you install ESXi on a robust system with more RAM than
the minimum required and with multiple physical disks.

Consider the following recommendations for enhanced performance:

n RAM – ESXi 4.0 hosts require more RAM than typical servers. An ESXi 4.0 host must be equipped with
sufficient RAM to run concurrent virtual machines.

For example, operating four virtual machines with Red Hat Enterprise Linux or Windows XP requires at
least 3GB of RAM for baseline performance. This includes approximately 1024MB for the virtual machines
(256MB minimum for each operating system as recommended by vendors).

Running these four virtual machines with 512MB RAM requires that the ESXi 4.0 host be equipped with
approximately 4GB RAM, which includes 2048MB for the virtual machines.

These calculations do not take into account possible memory savings from using variable overhead
memory for each virtual machine. See the Resource Management Guide.

n Dedicated Fast Ethernet adapters for virtual machines – Place the management network and virtual
machine networks on different physical network cards. Dedicated Gigabit Ethernet cards for virtual
machines, such as Intel PRO 1000 adapters, improve throughput to virtual machines with high network
traffic.

n Disk location – Place all data used by your virtual machines on physical disks allocated specifically to
virtual machines. Performance is better when you do not place your virtual machines on the disk
containing the ESXi 4.0 Installable boot image. Use physical disks that are large enough to hold disk images
used by all the virtual machines.

n VMFS3 partitioning – The ESXi 4.0 installer creates the initial VMFS volumes automatically on blank local
disks. To add disks or modify the original configuration, use the vSphere Client. This application ensures
that the starting sectors of partitions are 64K-aligned, which improves storage performance.

NOTE   For SAS-only environments, the installer might not format the disks. For some SAS disks, it is
difficult to identify whether the disks are local or remote. After the installation, you can use the vSphere
Client to set up VMFS.

n Processors – Faster processors improve ESXi 4.0 performance. For certain workloads, larger caches
improve ESXi 4.0 performance.

n Hardware compatibility – Use devices in your server that are supported by ESXi 4.0 drivers. See the
Hardware Compatibility Guide at http://www.vmware.com/resources/compatibility.
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vCenter Server and the vSphere Client Hardware Requirements
The vCenter Server system is a physical machine or virtual machine with access to a supported database. The
vCenter Server system and the vSphere Client machines must meet specific requirements.

Minimum Requirements for vCenter Server
n CPU – 2 CPUs

n Processor – 2.0GHz or faster Intel or AMD processor. Processor requirements might be higher if the
database runs on the same machine.

n Memory – 3GB RAM. Memory requirements might be higher if the database runs on the same machine.

vCenter Server includes a service called VMware VirtualCenter Management Webservices. This service
requires 128MB to 1.5GB of additional memory. The VirtualCenter Management Webservices process
allocates the required memory at startup.

n Disk storage – 2GB. Disk requirements might be higher if the database runs on the same machine.

n Microsoft SQL Server 2005 Express disk requirements – Up to 2GB free disk space to decompress the
installation archive. Approximately 1.5GB of these files are deleted after the installation is complete.

n Networking – Gigabit connection recommended.

See your database documentation for the hardware requirements of your database. The database requirements
are in addition to the vCenter Server requirements if the database and vCenter Server run on the same machine.

Minimum Requirements for the vSphere Client
n CPU – 1 CPU

n Processor – 266MHz or faster Intel or AMD processor (500MHz recommended).

n Memory – 200MB RAM

n Disk Storage – 1GB free disk space for a complete installation, which includes the following components:

n Microsoft .NET 2.0

n Microsoft .NET 3.0 SP1

n Microsoft Visual J#

n vSphere Client 4.0

n vSphere Host Update Utility 4.0

You must also have 400MB free on the drive that has your %temp% directory.

If all of the prerequisites are already installed, 300MB of free space is required on the drive that has your
%temp% directory, and 450MB is required for the vSphere Client 4.0.

n Networking – Gigabit connection recommended.

32-Bit or 64-Bit Operating System for vCenter Server
When you have up to 200 hosts, you can use a 32-bit Windows operating system, but a 64-bit Windows
operating system is preferred. When you have 200–300 hosts, a 64-bit Windows operating system is required.
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Recommendations for Optimal Performance
Depending on the number of ESX hosts and virtual machines in your environment, the following system
requirements should be used as guidelines for optimal performance.

IMPORTANT   The recommended disk sizes assume default log levels. If you configure more granular log levels,
more disk space is required.

Table 4-3 summarizes the requirements for a medium deployment.

Table 4-3.  Up to 50 Hosts and 250 Powered-On Virtual Machines

Product CPU Memory Disk

vCenter Server 2 4GB 3GB

vSphere Client 1 200MB 1GB

Table 4-4 summarizes the requirements for a large deployment.

Table 4-4.  Up to 200 Hosts and 2000 Powered-On Virtual Machines

Product CPU Memory Disk

vCenter Server 4 4GB 3GB

vSphere Client 1 500MB 1GB

Table 4-5 summarizes the requirements for an extra-large deployment.

vCenter Server must be hosted on a 64-bit Windows operating system for this configuration.

Table 4-5.  Up to 300 Hosts and 3000 Powered-On Virtual Machines

Product CPU Memory Disk

vCenter Server 4 8GB 3GB

vSphere Client 1 500MB 1GB

Requirements for Installing vCenter Server on a Custom Drive
If you install vCenter Server on the E:\ drive or on any custom drive, note the following space requirements.

n 601MB on the custom drive for vCenter Server

n 1.13GB on the C:\ drive for Microsoft .NET 3.0 SP1, Microsoft ADAM, Microsoft SQL Server 2005 Express
(optional), and Microsoft Visual C++ 2005 Redistributable

n 375MB for the custom drive %temp% directory

vCenter Server Software Requirements
Make sure that your operating system supports vCenter Server.

For a list of supported operating systems, see the vSphere Compatibility Matrixes at 
http://www.vmware.com/pdf/vsphere4/r40/vsp_compatibility_matrix.pdf on the VMware vSphere
documentation Web site.
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vSphere Client Software Requirements
Make sure that your operating system supports the vSphere Client.

The vSphere Client requires the Microsoft .NET 3.0 SP1 Framework. If your system does not have it installed,
the vSphere Client installer installs it.

For a list of supported operating systems, see the vSphere Compatibility Matrixes at 
http://www.vmware.com/pdf/vsphere4/r40/vsp_compatibility_matrix.pdf on the VMware vSphere
documentation Web site.

Support for 64-Bit Guest Operating Systems
ESX offers support for several 64-bit guest operating systems.

See the Guest Operating System Installation Guide for a complete list.

64-bit guest operating systems have specific hardware requirements:

n For AMD Opteron-based systems, the processors must be Opteron Rev E and later.

n For Intel Xeon-based systems, the processors must include support for Intel Virtualization Technology
(VT). Many servers that include CPUs with VT support might ship with VT disabled by default, so you
must enable VT manually. If your CPUs support VT but you do not see this option in the BIOS, contact
your vendor to request a BIOS version that lets you enable VT support.

To determine whether your server has 64-bit VMware support, you can download the CPU Identification
Utility at the VMware downloads page: http://www.vmware.com/download/shared_utilities.html.

Requirements for Creating Virtual Machines
To create a virtual machine, the ESX/ESXi host must be able to support a virtual process, a virtual chip set, and
a virtual BIOS.

Each ESX/ESXi machine has the requirements shown in Table 4-6.

Table 4-6.  Requirements for Creating Virtual Machines

Component Requirements

Virtual processor One, two, four, or eight processors per virtual machine
NOTE If you create a two-processor virtual machine, your ESXi machine must have
at least two physical core in processor.

Virtual chip set Intel 440BX-based motherboard with NS338 SIO chip

Virtual BIOS PhoenixBIOS 4.0 Release 6

Required Ports
vCenter Server requires certain ports to send and receive data.

The vCenter Server system must be able to send data to every managed host and receive data from every
vSphere Client. To enable migration and provisioning activities between managed hosts, the source and
destination hosts must be able to receive data from each other.
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VMware uses designated ports for communication. Additionally, the managed hosts are listening for data from
the vCenter Server system on designated ports. If a firewall exists between any of these elements and Windows
firewall service is in use, the installer opens the ports during the installation. For custom firewalls, you must
manually open the required ports. If you have a firewall between two managed hosts and you want to perform
source or target activities, such as migration or cloning, you must configure a means for the managed hosts to
receive data.

NOTE   In Microsoft Windows 2008, a firewall is enabled by default.

Table 4-7 lists the default ports that are required for communication between components.

Table 4-7.  Required Ports

Port Description

80 vCenter Server requires port 80 for direct HTTP connections. Port 80 redirects requests to HTTPS port
443. This is useful if you accidentally use http://server instead of https://server.

389 This port must be open on the local and all remote instances of vCenter Server. This is the LDAP port
number for the Directory Services for the vCenter Server group. The vCenter Server system needs to
bind to port 389, even if you are not joining this vCenter Server instance to a Linked Mode group. If
another service is running on this port, it might be preferable to remove it or change its port to different
port. If needed, you can run the LDAP service on any port from 1025 through 65535.
If this instance is serving as the Microsoft Windows Active Directory, change the port number from 389
to an available port from 1025 through 65535.

443 The default port that the vCenter Server system uses to listen for connections from the vSphere Client.
To enable the vCenter Server system to receive data from the vSphere Client, open port 443 in the
firewall.
The vCenter Server system also uses port 443 to listen for data transfer from the vSphere Web Access
Client and other SDK clients.
If you use another port number for HTTPS, you must use <ip-address>:<port> when you log in to the
vCenter Server system.

636 For vCenter Linked Mode, this is the SSL port of the local instance. If another service is running on this
port, it might be preferable to remove it or change its port to different port. If needed, you can run the
SSL service on any port from 1025 through 65535.

902 The default port that the vCenter Server system uses to send data to managed hosts. Managed hosts
also send a regular heartbeat over UDP port 902 to the vCenter Server system. This port must not be
blocked by firewalls between the server and the hosts, or between hosts.

902/903 Ports 902 and 903 must not be blocked between the vSphere Client and the hosts. These ports are used
by the vSphere Client to display virtual machine consoles.

8080 Web Services HTTP. Used for the VMware VirtualCenter Management Webservices.

8443 Web Services HTTPS. Used for the VMware VirtualCenter Management Webservices.

If you want the vCenter Server system to use a different port to receive vSphere Client data, see Basic System
Administration.

To tunnel the vSphere Client data through the firewall to the receiving port on the vCenter Server system, see
Basic System Administration. VMware does not recommended this method because it disables the vCenter Server
console function.

For a discussion of firewall configuration, see the Server Configuration Guide.

DNS Requirements for vSphere
You can install vCenter Server, like any other network server, on a machine with a fixed IP address and well-
known DNS name, so that clients can reliably access the service.

Assign a static IP address and host name to the Windows server that will host the vCenter Server system. This
IP address must have a valid (internal) domain name system (DNS) registration.
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Ensure that the ESXi host management interface has a valid DNS resolution from the vCenter Server and all
vSphere Clients and vSphere Web Clients. Ensure that the vCenter Server has a valid DNS resolution from all
ESXi hosts and all vSphere Clients and vSphere Web Clients. Ensure that the vCenter Server is installed on a
machine that has a resolvable fully qualified domain name (FQDN).

If you use DHCP instead of a static IP address for vCenter Server, make sure that the vCenter Server computer
name is updated in the domain name service (DNS). Ping the computer name to test the connection. For
example, if the computer name is host-1.company.com, you can ping the name by running the following
command in the Windows command prompt:

ping host-1.company.com

If you can ping the computer name, the name is updated in DNS.

Supported Remote Management Firmware Versions
You can use remote management applications for installing ESX or for remote management of ESX/ESXi.

Table 4-8 lists the remote management firmware versions that are supported for installing ESX  4.0 remotely.

NOTE   If you are using a remote management application to access the ESXi direct console, consider enabling
high-contrast mode in the direct console by pressing F4.

Table 4-8.  Supported Remote Management Server Models and Firmware Versions

Remote Controller
Make and Model Firmware Version Java ActiveX

DRAC 5 1.4 Not applicable 1.4.2_19

1.45 (08.10.06) 2.1,0,14 1.6.0.50

1.40 (08.08.22) 2,1,0,14 1.6.0_11

1.20 (07.03.02) 1.4.2_06 2,1,0,13

1.33 1.6.0_07 2,1,0,14

1.32 (07.12.22) 1.4.2_13 2,1,0,13

1.0 (06.05.12) 1.4.2_13 2,1,0,13

1.32 1.6.0_11 2,1,0,14

1.2 1.6.0_11 2,1,0,14

1.45 (09.01.16) 1.6.0_11 2,1,0,14

1.3 1.6.0_11 2,1,0,14

1.33 1.6.0_11 2,1,0,13

DRAC 4 1.7 1.4.2_06 2,1,0,14

ILO .26 1.6.0_11 2,1,0,14

1.7 1.4.2_19 Not applicable

ILO2 1.91 (07/26/2009) 1.6.0_07 2,1,0,14

1.29 (2/28/2007) 1.4.2_13 Not applicable

RSA 1.09 1.6.0_11 2,1,0,14

1.06 1.6.0_11 2,1,0,14
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Preparing for the Upgrade to vCenter
Server 5

Before you upgrade to vCenter Server, review the prerequisites.

This chapter includes the following topics:

n “About the vCenter Server 4.0 Upgrade,” on page 37

n “vCenter Server Upgrade Summary,” on page 37

n “Prerequisites for the vCenter Server Upgrade,” on page 38

n “vCenter Server Database Patch and Configuration Requirements,” on page 40

n “Database Scenarios,” on page 41

n “Configure vCenter Server to Communicate with the Local Database After Shortening the Computer
Name to 15 Characters or Fewer,” on page 42

n “Back Up VirtualCenter 2.x,” on page 43

n “Downtime During the vCenter Server Upgrade,” on page 43

About the vCenter Server 4.0 Upgrade
If you have VirtualCenter 2.x and you want to manage ESX 4.0/ESXi 4.0, you must upgrade the VirtualCenter
software to vCenter Server 4.0.

ESX 4.0 and ESXi 4.0 hosts that are managed together in a vCenter Server system can run the same virtual
machines, use VMotion to migrate virtual machines between the hosts, and access the same datastores.

You can manage ESX 3.x/ESXi 3.5 hosts in the same cluster with ESX 4.0/ESXi 4.0 hosts. You can manage ESX
2.x as standalone hosts in a vCenter Server system. ESX 2.x hosts cannot be added to clusters.

vCenter Server Upgrade Summary
The upgrade to vCenter Server impacts other software components of your datacenter.

Table 5-1 summarizes the impacts on your datacenter components.

Table 5-1.  Upgrading vCenter Server Components

Product Component Description

vCenter Server VI Client 1.x Not supported

VirtualCenter Server 1.x Not supported

vSphere Client 4.0 Install
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Table 5-1.  Upgrading vCenter Server Components (Continued)

Product Component Description

VirtualCenter Server 2.5 Upgrade

vCenter Server 4.0 Install

Oracle database Verify that your database is supported. Upgrade if necessary.
Oracle 9i is no longer supported.

SQL database Verify that your database is supported. Upgrade if necessary.
Microsoft SQL Server 2000 is no longer supported.

Linked Mode Cannot join a Linked Mode group during the upgrade procedure.
Join after the upgrade to vCenter Server is complete.

License server License server To manage ESX 3.x/ESXi 3.5 hosts, verify that the vCenter Server
system is configured to use a license server. Install a license server
if necessary.

ESX ESX 2.5 host Supported with vCenter Server 4.0, but cannot add the hosts to
clusters.

VMFS2 volumes Supported as read-only (deprecated)

ESX2 virtual machines Support for ESX 2 virtual machines (virtual hardware version 3)
starts with ESX 2. Support continues through ESX 4.0. Upgrade is
optional, but strongly recommended.

VMDK2 virtual disk The file layout introduced with ESX 2. Support continues through
ESX 4.0. This is a single file with meta-data at the end.

ESX MUI No change

VMware Tools Upgrade (optional)

ESX 3.x/ESXi 3.5 host Upgrade to ESX 4.0 (optional)

VMFS3 volumes No change

ESX3 virtual machines Support for ESX 3 virtual machines (virtual hardware version 4)
starts with ESX 3. Support continues through ESX 4.0. Upgrade is
optional.

VMDK3 virtual disk The file layout introduced with ESX 3. Support continues through
ESX 4.0. This is a two-file layout where a small descriptor file points
to a data-file. This format allows features such as multiple
snapshots.

Prerequisites for the vCenter Server Upgrade
Before you begin the upgrade to vCenter Server, make sure you have the vCenter Server system and the
database are properly prepared.

vCenter Server Prerequisites
The following items are prerequisites for completing the upgrade to vCenter Server:

n VirtualCenter Server 2.x installed on a machine that supports vCenter Server 4.0.

n VMware vCenter Server 4.0 installation media.

n License keys for all purchased functionality.

If you do not currently have the license key, you can install in evaluation mode and use the vSphere Client
to enter the license key later.
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n The installation path of the previous version of VirtualCenter must be compatible with the installation
requirements for Microsoft Active Directory Application Mode (ADAM/AD LDS). For example the
installation path cannot have commas (,) or periods (.). If your previous version of VirtualCenter does
not meet this requirement, you must perform a clean installation of vCenter Server 4.0.

n Make sure the system on which you are installing vCenter Server is not an Active Directory domain
controller, primary or backup.

n Make sure that the computer name has no more than 15 characters.

n vCenter Server 4.0 uses TCP/IP Ports 80 and 443 for the VMware vSphere Web client. You cannot run
vCenter Server on the same machine as a Web server using TCP/IP port 80 (HTTP) or port 443 (HTTPS)
because doing so causes port conflicts.

n If you use vCenter Guided Consolidation Service in the VirtualCenter 2.x environment, complete the
consolidation plan before you upgrade to vCenter Server 4.0. The upgrade to vCenter Server 4.0 does not
preserve or migrate any data gathered by the vCenter Guided Consolidation Service. After the upgrade,
all of the data is cleared, and you cannot restore it.

n Back up the SSL certificates that are on the VirtualCenter 2.x system before you upgrade to
vCenter Server 4.0.

n If you upgrade to vCenter Server on Windows Server 2003 SP1, the disk for the installation directory must
have the NTFS format, not the FAT32 format.

n If you use DHCP instead of a static IP address for vCenter Server, make sure that the vCenter Server
computer name is updated in the domain name service (DNS). One way to test this is by pinging the
computer name. For example, if the computer name is host-1.company.com, run the following command
in the Windows command prompt:

ping host-1.company.com

If you can ping the computer name, the name is updated in DNS.

Database Prerequisites
Before you upgrade to vCenter Server, consider the following points:

n If your database server is not supported by vCenter Server, perform a database upgrade to a supported
version or import your database into a supported version. See “Database Scenarios,” on page 41.

n You must perform a complete backup of your VirtualCenter 2.x database before you begin the
vCenter Server upgrade. The VirtualCenter 2.x database schema is not compatible with vCenter Server 4.0.
The vCenter Server 4.0 installer upgrades your existing VirtualCenter Server database schema with extra
fields, thus making the database unusable by VirtualCenter 2.x.

n You must have login credentials, the database name, and the database server name that will be used by
the vCenter Server database. The database server name is typically the ODBC System data store name
(DSN) connection name for the vCenter Server database.

n To use a newly supported Oracle database, such as Oracle 11g, you do not need to perform a clean
installation of vCenter Server if your existing database is also Oracle. For example, you can first upgrade
your existing Oracle 9i database to Oracle 10g or Oracle 11g and then upgrade VirtualCenter 2.x to
vCenter Server 4.0.

n To use a newly supported SQL database, such as Microsoft SQL 2008, you do not need to perform a clean
installation of vCenter Server if your existing database is also Microsoft SQL Server. For example, you can
upgrade a Microsoft SQL Server 2000 database to Microsoft SQL Server 2005 or Microsoft SQL Server 2008
and then upgrade VirtualCenter 2.x to vCenter Server 4.0.

n If you are upgrading from VirtualCenter 2.0.x and you are using the previously bundled demonstration
MSDE database, you must perform a clean installation of vCenter Server. VirtualCenter 2.0.x with the
demonstration MSDE database has no supported upgrade path to vCenter Server 4.0.
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n If you are upgrading from VirtualCenter 2.5 with the bundled SQL Server 2005 Express, you do not need
to perform a clean installation of vCenter Server.

n If you have a Microsoft SQL database and you are upgrading from VirtualCenter 2.0.x, make sure that
bulk logging is enabled. You can disable it after the upgrade is complete.

n If you have a Microsoft SQL database, your system DSN must be using the SQL Native Client driver.

n Make sure that the database user has the following permissions:

n Oracle Either assign the DBA role or grant the following permissions to the
user:

grant connect to <user>

grant resource to <user>

grant create view to <user>

grant create any sequence to <user> # For upgrade from VC 2.0.x

grant create any table to <user> # For upgrade from VC 2.0.x

grant execute on dbms_lock to <user> # For upgrade from VC 

2.0.x/2.5

grant unlimited tablespace to <user> # To ensure sufficient 

space

After the upgrade is complete, you can optionally remove the following
permissions from the user profile: create any sequence and create any
table.

By default, the RESOURCE role has the CREATE PROCEDURE,
CREATE TABLE, and CREATE SEQUENCE privileges assigned. If the
RESOURCE role does not have these privileges, grant them to the
vCenter Server database user.

n Microsoft SQL Server Make sure that the database login has the db_owner fixed database role
on the vCenter Server database and on the MSDB database. The
db_owner role on the MSDB database is required for installation and
upgrade only. You can revoke this role after the installation or upgrade
process is complete.

n Also review “Database Scenarios,” on page 41.

vCenter Server Database Patch and Configuration Requirements
After you choose a database type, make sure you understand the configuration and patch requirements for
the database.

NOTE   vCenter Update Manager also requires a database. VMware recommends that you use separate
databases for vCenter Server and vCenter Update Manager.

If your VirtualCenter 2.x database is not supported for upgrade to vCenter Server 4.0, first upgrade your
database (or import your database into a database that is supported for upgrade to vCenter Server) and then
upgrade to vCenter Server.

Table 5-2 lists the configuration and patch requirements for the databases that are supported for upgrade to
vCenter Server. If your database is not listed in this table, see “Database Scenarios,” on page 41.

For a complete list of database versions supported with vCenter Server, see the Compatibility Matrixes on the
VMware vSphere documentation Web site.
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Table 5-2.  Configuration and Patch Requirements

Database Type Patch and Configuration Requirements

Microsoft SQL Server 2005
Express

Bundled database that you can use for small deployments of up to 5  hosts and 50  virtual
machines.
You cannot install the bundled database during an upgrade to vCenter Server. If you want to
use the bundled database, Microsoft SQL Server 2005 Express must be already installed or
you must perform a clean installation of vCenter Server.

Microsoft SQL Server 2005 For Microsoft Windows XP, apply MDAC  2.8 SP1 to the client. Use the SQL Native Client
driver (version 9.x) for the client.
Ensure that the machine has a valid ODBC DSN entry.

Microsoft SQL Server 2008 For Microsoft Windows XP, apply MDAC  2.8 SP1 to the client. Use the SQL Native Client
driver (version 10.x) for the client.
Ensure that the machine has a valid ODBC DSN entry.

Oracle 10g If necessary, first apply patch 10.2.0.4 (or later) to the client and server. Then apply patch
5699495 to the client.
Ensure that the machine has a valid ODBC DSN entry.
For the Oracle Instant client, copy ojdbc14.jar to the vCenter Server tomcat directory
(<vCenter install location>\Infrastructure\tomcat\lib)
The Oracle 10g client comes with ojdbc14.jar (<Oracle client install
location>\oracle\product\10.2.0\<instance_name>\jdbc\lib). The vCenter Server
installer copies the file from the Oracle client install location to the vCenter Server tomcat
directory (<vCenter install location>\Infrastructure\tomcat\lib)
If the ojdbc14.jar file is not found in the Oracle 10g client location, the vCenter Server installer
prompts you to copy the file manually. You can download the file from 
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc101040.html.

Oracle 11g Ensure that the machine has a valid ODBC DSN entry.
For the Oracle Instant client, copy ojdbc14.jar to the vCenter Server tomcat directory
(<vCenter install location>\Infrastructure\tomcat\lib)
The Oracle 11g client comes with ojdbc14.jar (<Oracle client install
location>\app\Administrator\product\11.1.0\<instancename>\sqldeveloper\jd
bc\lib). The vCenter Server installer copies the file from the Oracle client install location to
the vCenter Server tomcat directory (<vCenter install
location>\Infrastructure\tomcat\lib)
If the ojdbc14.jar file is not found in the Oracle 11g client location, the vCenter Server installer
prompts you to copy the file manually. You can download the file from 
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc101040.html.

Database Scenarios
When you upgrade to vCenter Server 4.0, you must make sure your database is supported with
vCenter Server 4.0.

Table 5-3 lists the database types that you can use with either VirtualCenter 2.x or vCenter Server, or both. This
is not a list of supported database versions. For a list of supported database versions, see the Compatibility
Matrixes on the VMware vSphere documentation Web site. The purpose of Table 5-3 is to describe the
vCenter Server upgrade scenarios for each database type.

Table 5-3.  vCenter Server Upgrade Scenarios for Each Database Type

Database Type
Supported in
VirtualCenter 2.x

Supported in
vCenter Server 4.0 Supported Scenario

Experimental
MSDE database

Yes (VirtualCenter 2.0.x) No After you upgrade to a database server that
is supported by vCenter Server, you can
perform a fresh installation or upgrade to
vCenter Server.

Microsoft SQL
Server 2005 Express

Yes Yes You can perform a fresh installation or
upgrade to vCenter Server.

Chapter 5 Preparing for the Upgrade to vCenter Server

VMware, Inc.  41

http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc101040.html
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc101040.html


Table 5-3.  vCenter Server Upgrade Scenarios for Each Database Type (Continued)

Database Type
Supported in
VirtualCenter 2.x

Supported in
vCenter Server 4.0 Supported Scenario

Microsoft SQL
Server 2000

Yes No After you upgrade to a database server that
is supported by vCenter Server, you can
perform a fresh installation or upgrade to
vCenter Server.

Microsoft SQL
Server 2005

Yes Yes You can perform a fresh installation or
upgrade to vCenter Server.

Microsoft SQL
Server 2008

No Yes You can perform a fresh installation or
upgrade to vCenter Server.

Oracle 9i Yes No After you upgrade to a database server that
is supported by vCenter Server, you can
perform a fresh installation or upgrade to
vCenter Server.

Oracle 10g Yes Yes You can perform a fresh installation or
upgrade to vCenter Server.

Oracle 11g No Yes You can perform a fresh installation or
upgrade to vCenter Server.

If you perform a fresh installation of vCenter Server 4.0, you can then import your database information into
a database that is supported by vCenter Server 4.0. For information about performing a fresh installation, see
the ESX and vCenter Server Installation Guide or the ESXi and vCenter Server Setup Guide. For information about
importing your database, see your database documentation or consult your database administrator.

Configure vCenter Server to Communicate with the Local Database
After Shortening the Computer Name to 15 Characters or Fewer

The machine on which you install or upgrade to vCenter Server must have a computer name that is 15
characters or fewer. If your database is located on the same machine that vCenter Server will be installed on
and you have recently changed the name of this machine to comply with the name-length requirement, make
sure the vCenter Server DSN is configured to communicate with the new name of the machine.

Changing the vCenter Server computer name impacts database communication if the database server is on the
same computer with vCenter Server. If you have changed the machine name, verify that communication
remains intact by completing the following procedure.

The name change has no impact on communication with remote databases. You can skip this procedure if your
database is remote.

NOTE   The name-length limitation applies to the vCenter Server system. The data source name (DSN) and
remote database systems can have names with more than 15 characters.

Check with your database administrator or the database vendor to make sure all components of the database
are working after you rename the server.

Procedure

1 Make sure the database server is running.

2 Make sure that the vCenter Server computer name is updated in the domain name service (DNS).

One way to test this is by pinging the computer name. For example, if the computer name is
host-1.company.com, run the following command in the Windows command prompt:

ping host-1.company.com

If you can ping the computer name, the name is updated in DNS.
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3 Update the data source information, as needed.

4 Verify the data source connectivity.

Back Up VirtualCenter 2.x
You must back up a VirtualCenter 2.x system to ensure that you can restore your previous configuration of
VirtualCenter if the vCenter Server upgrade does not complete successfully.

If you begin the upgrade to vCenter Server, and you did not back up your VirtualCenter 2.x database and SSL
certificates, you cannot restore your previous VirtualCenter configuration. You cannot roll back your database
to the previous database schema. The only way to recover from an unsuccessful upgrade is to use your backed
up database and SSL certificates.

Procedure

1 Make a full backup of the VirtualCenter 2.x database.

See your database documentation.

2 Back up the VirtualCenter 2.x SSL certificates.

a Copy the SSL certificate folder under %ALLUSERSPROFILE%\Application Data\VMware\VMware
VirtualCenter or %ALLUSERSPROFILE%\VMware\VMware VirtualCenter\.

b Paste it at the backup location.

3 Take notes on the existing VirtualCenter installation regarding the selections, settings, and information
used. For example, note any nondefault settings, such as the IP address, the database DSN, user name,
password, and assigned ports.

4 Create a backup copy of vpxd.cfg.

What to do next

Continue with the upgrade to vCenter Server.

Downtime During the vCenter Server Upgrade
When you upgrade to vCenter Server, no downtime is required for the ESX/ESXi hosts that vCenter Server is
managing. Nor is downtime required for the virtual machines that are running on the hosts. Downtime is
required for vCenter Server.

Expect downtime for vCenter Server as follows:

n VMware estimates that the upgrade requires vCenter Server to be out of production for 10 minutes, plus
15 to 20 minutes for the database schema upgrade, depending on the size of the database. This estimate
does not include host reconnection after the upgrade.

If the machine does not have Microsoft .NET Framework already installed, a reboot will be required after
the upgrade to vCenter Server.

n VMware Distributed Resource Scheduler does not work while the upgrade is in progress. VMware HA
does work during the upgrade.

Chapter 5 Preparing for the Upgrade to vCenter Server
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Upgrading to vCenter Server 4.0 6
The upgrade to vCenter Server includes a database schema upgrade and an upgrade of VirtualCenter 2.x.

This chapter includes the following topics:

n “About the Database Upgrade Wizard,” on page 45

n “Upgrade to vCenter Server,” on page 45

About the Database Upgrade Wizard
The Database Upgrade wizard updates the schema of the VirtualCenter database. The Database Upgrade
wizard runs after you complete the vCenter Server installation wizard.

When you perform an upgrade to vCenter Server, you must use a VirtualCenter 2.x database that is supported
for upgrade by vCenter Server 4.0.

The Database Upgrade wizard runs after you click Install in the vCenter Server installer. The Database
Upgrade wizard upgrades the database schema to make it compatible with vCenter Server 4.0. The schema
defines the tables, the fields in each table, and the relationships between fields and tables.

If you are upgrading from VirtualCenter 2.5, the Database Upgrade wizard runs in the background. If you are
upgrading from VirtualCenter 2.0.x, the Database Upgrade wizard appears and you must complete the wizard.

The Database Upgrade wizard does not upgrade an unsupported database version (for example, Oracle 9i)
into a supported database.

CAUTION   You cannot use the updated database schema with previous versions of VirtualCenter. You cannot
roll back the schema update. You must create a back up of your database before you upgrade your database
and before you begin the upgrade to vCenter Server.

Upgrade to vCenter Server
The vCenter Server installer detects any VirtualCenter 2.x release and upgrades it.

This procedure requires downtime for the VirtualCenter Server that you are upgrading. No virtual machines
need to be powered off.

If the upgrade fails, there is no automatic rollback to the previous VirtualCenter version.

Prerequisites

The prerequisites for upgrading to vCenter Server include requirements for the vCenter Server system and
requirements for the database. See “Prerequisites for the vCenter Server Upgrade,” on page 38.
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Procedure

1 Select Start > Control Panel > Administrative Tools > Services > VMware VirtualCenter Server to stop
the service.

This step is recommended, especially if the VirtualCenter database is on a remote system.

2 As Administrator on the Windows system, insert the VMware vCenter Server Installation CD or double-
click autorun.exe.

3 When the vCenter Server Installer page appears, click vCenter Server.

4 Select a language for the installer and click OK.

5 The Welcome page informs you that an earlier version of VirtualCenter is on the computer and will be
upgraded to vCenter Server 4.0.

When the Welcome page appears, click Next.

6 Select I agree to the terms in the license agreement and click Next.

7 Type your vCenter Server license key and clickNext.

If you omit the license key, vCenter Server will be in evaluation mode. After installation, you can convert
vCenter Server to licensed mode by entering the license key using the vSphere Client.

8 Enter the database password that corresponds to the username and DSN that the installer displays and
click Next.

You can omit the database username and password if the DSN is using Windows NT authentication.

If you specify a remote SQL Server database that uses Windows NT authentication, the database user and
the logged-in user on the vCenter Server machine must be the same.

9 Select whether to upgrade the vCenter Server database schema.

n Select Yes, I want to upgrade my vCenter Server database to continue with the upgrade to
vCenter Server.

n Select No, I do not want to upgrade my vCenter Server database if you do not have a backup copy
of your database.

If you choose this option, you cannot continue the upgrade. Cancel the upgrade, back up your
VirtualCenter environment (as described in “Back Up VirtualCenter 2.x,” on page 43), and restart the
upgrade process.

If the database schema is current, this dialog does not appear.

10 Click I have taken a backup of the existing vCenter Server database and SSL certificates and click
Next.

11 Specify the account for the vCenter Service to run in.

n Click Next to use the SYSTEM account. You cannot use the SYSTEM account if you are using Windows
authentication for SQL Server.

n Deselect Use SYSTEM Account, accept the default Administrator account name and password, and
click Next.

n Deselect Use SYSTEM Account and enter a different Administrator account name and password.

12 Enter the port numbers to use or accept the default port numbers shown on the page and click Next.

13 Click Install.

If you are upgrading from VirtualCenter 2.0.x, the Database Upgrade wizard appears. The upgrade is not
complete until the wizard upgrades the database schema. If you are upgrading from VirtualCenter 2.5, the
database schema is upgraded in the background.
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What to do next

See Chapter 8, “Postupgrade Considerations for vCenter Server,” on page 55.

Upgrade the vCenter Server Database Schema
When you upgrade to vCenter Server and use an existing supported database, the Database Upgrade wizard
runs after you click Install in the vCenter Server installer. The Database Upgrade wizard upgrades the existing
database schema to make it compatible with vCenter Server 4.0.

For upgrades from VirtualCenter 2.5, the Database Upgrade wizard runs in the background. This procedure
is for upgrades from VirtualCenter 2.0.x.

Procedure

1 In the Database Upgrade wizard Welcome page, click Next.

2 On the Upgrade Information screen, select an option for performance data.

n Select Keep all performance data and click Next to preserve performance data from your existing
database.

n Select Discard all performance data and click Next to discard performance data from your existing
database.

n Select Keep performance data recorded during past 12 months and click Next to preserve only the
most recent performance data from your existing database.

The table for performance data can be large. If you do not keep the table, you cannot view historical
performance statistics for the time when the database was maintained in VirtualCenter 2.x.

3 Review your selections, click Next, and click Start.

Your database is now compatible with vCenter Server 4.0. It is no longer compatible with VirtualCenter
2.x. The vCenter Server installer begins installing vCenter Server 4.0.

4 Click Finish to complete the upgrade to vCenter Server.

VirtualCenter 2.x is upgraded to vCenter Server 4.0.

What to do next

To view the upgrade log, open %TEMP%\VCDatabaseUpgrade.log.

Chapter 6 Upgrading to vCenter Server 4.0
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Upgrading to vCenter Server on a
Different Machine and Keeping the
Existing Database 7

When you upgrade to vCenter Server, you can install vCenter Server on a new machine. One common reason
for doing this is to run vCenter Server on a 64-bit machine.

Preparing the database for any type of upgrade always means creating a full backup. In addition, you have
the following options:

n After you create a full backup of the database, leave it where it is. This option makes sense if your database
is remote from VirtualCenter, and you want it to remain remote after the upgrade to vCenter Server.

n After you create a full backup of the database, restore it onto the machine on which you are installing
vCenter Server. This option makes sense if the database is local to VirtualCenter and you want it to be
local after the upgrade to vCenter Server.

n For Microsoft SQL Server databases only, create a full backup of the database, detach the database, and
attach it to the machine on which you are installing vCenter Server. This option makes sense if the database
is local to VirtualCenter and you want it to be local after the upgrade to vCenter Server.

For Microsoft SQL Server databases, when you decide between the backup/restore option or the detach/attach
option, consider the downtime required. For guidance on these options, consult your organization's database
administrator.

This chapter includes the following topics:

n “Back Up and Restore a Microsoft SQL Database,” on page 49

n “Detach and Attach a Microsoft SQL Server Database,” on page 50

n “Back Up and Restore an Oracle Database,” on page 51

n “Create a 32-Bit DSN on a 64-Bit Operating System,” on page 52

n “Upgrade to vCenter Server on a Different Machine,” on page 52

Back Up and Restore a Microsoft SQL Database
Before you perform an upgrade to vCenter Server on a different machine, you might want to move the database
as well. Moving the database is optional. To move a Microsoft SQL Server database, you can perform a backup
and restore operation.

Consult your database administrator or see your database documentation about backing up and restoring
databases.

The machine with the VirtualCenter 2.x database is referred to as the source machine. The machine on which
the vCenter Server 4.0 database will reside is referred to as the destination machine.

Prerequisites

n You must have a VirtualCenter 2.x system running with a local or remote Microsoft SQL Server database.
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n You must have Microsoft SQL Server Management Studio installed on the source machine and the
destination machine. The Express versions (SQLServer2005_SSMSEE.msi and
SQLServer2005_SSMSEE_x64.msi) are free downloads from Microsoft.

Procedure

1 In SQL Server Management Studio, make a full back up of the source machine database.

2 Copy the backup file (.bak) to the C:\ drive on the destination machine.

3 On the destination machine, open SQL Server Management Studio and right-click the Databases folder.

4 Select New Database, enter the source machine database name, and click OK.

5 Right-click the new database icon and select Task > Restore > Database.

6 Select From Device and click Browse.

7 Click Add, navigate to the backup file, and click OK.

8 In the Restore Database window, select the checkbox next to your .bak file.

9 On the Options page, select the Overwrite the existing database checkbox and click OK.

The VirtualCenter 2.x database is successfully restored onto the new database, which you can use for the
upgrade to vCenter Server 4.0.

What to do next

See “Upgrade to vCenter Server on a Different Machine,” on page 52.

Detach and Attach a Microsoft SQL Server Database
Before you perform an upgrade to vCenter Server on a 64-bit machine, you can optionally detach the
VirtualCenter 2.x database from the source machine and attach it to the destination machine. This is an
alternative to the backup and restore operation.

Consult your database administrator or see your database documentation about detaching and attaching
databases.

The machine with the VirtualCenter 2.x database is referred to as the source machine. The machine on which
the vCenter Server 4.0 database will reside is referred to as the destination machine.

Prerequisites

n Take a full backup of the database.

n You must have a VirtualCenter 2.x system running with a local or remote Microsoft SQL Server database.

n You must have Microsoft SQL Server Management Studio installed on the source machine and the
destination machine. The Express versions (SQLServer2005_SSMSEE.msi and
SQLServer2005_SSMSEE_x64.msi) are free downloads from Microsoft.

Procedure

1 On the source machine, stop the VirtualCenter service.

a Selecting Start > Control Panel > Administrative Tools > Services > VMware VirtualCenter Server.

b Right-click VMware VirtualCenter Server and select Stop.

2 In the SQL Server Management Studio, open the Databases directory, right-click the VirtualCenter 2.x
database, and select Tasks > Detach.

3 Select the database and click OK.
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4 When the detach operation is complete, copy the data files (.mdf and .ldf) to the destination machine's
database folder.

By default, the database folder is C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data.

5 In SQL Server Management Studio on the destination machine, right-click the Databases directory and
select Attach.

6 Select the .mdf file that you copied to the destination machine's database folder and click OK.

The database from the source machine is attached to the destination machine.

What to do next

n See http://kb.vmware.com/kb/1004382. As indicated in Knowledge Base article 1004382, detaching and
attaching the vCenter Server database to a different Microsoft SQL Server does not copy over the vCenter
Server specific SQL Agent daily, weekly, and monthly rollup jobs. Therefore, in KB 1004382, see "verifying
the existence of jobs and removing them."

n See “Upgrade to vCenter Server on a Different Machine,” on page 52. This information applies when
you migrate vCenter Server to a different machine. For example, because the hardware is being
decommissioned or the operating system is no longer supported because of an upgrade.

Back Up and Restore an Oracle Database
Before you perform an upgrade to vCenter Server on a different machine, you might want to move the database
as well. Moving the database is optional. To move an Oracle database, you perform a backup and restore
operation.

Consult your database administrator or see your database documentation about backing up and restoring
databases.

The machine with the VirtualCenter 2.x database is referred to as the source machine. The machine on which
the vCenter Server 4.0 database will reside is referred to as the destination machine.

Prerequisites

You must have a VirtualCenter 2.x system running with a local or remote Oracle 10g or Oracle 11g database.

Procedure

1 On the source machine, log in to Oracle SQL*Plus as the VirtualCenter 2.x database user and export the
database as a .dmp file.

2 Copy the .dmp file onto the C:\ drive of the destination machine.

3 In Oracle SQL*Plus, run the following command to create the tablespace.

create tablespace vctest datafile 'c:\vctest.dbf' size 100m autoextend on;

4 Create a user. 

create user VCUSER identified by CENSORED default tablespace vctest;

5 Import the .dmp file into the Oracle 64-bit database on the destination machine.

The VirtualCenter 2.x database is restored onto the new database, which you can use for the upgrade to
vCenter Server 4.0.

What to do next

See “Upgrade to vCenter Server on a Different Machine,” on page 52.
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Create a 32-Bit DSN on a 64-Bit Operating System
You can install or upgrade to vCenter Server on both 32-bit and 64-bit operating systems.

Even though vCenter Server is supported on 64-bit operating systems, the vCenter Server system must have
a 32-bit DSN. This requirement applies to all supported databases. By default, any DSN created on a 64-bit
system is 64 bit.

Procedure

1 Install the ODBC drivers.

n For Microsoft SQL Server database servers, install the 64-bit database ODBC drivers on your Microsoft
Windows system. When you install the 64-bit drivers, the 32-bit drivers are installed automatically.

n For Oracle database servers, install the 32-bit database ODBC drivers on your Microsoft Windows
system.

NOTE   The default install location on 64-bit operating systems is C:\VMware.

2 Run the 32-bit ODBC Administrator application, located at [WindowsDir]\SysWOW64\odbcad32.exe.

3 Use the application to create your DSN.

You now have a DSN that is compatible with vCenter Server. When the vCenter Server installer prompts you
for a DSN, select the 32-bit DSN.

Upgrade to vCenter Server on a Different Machine
In this type of upgrade, you upgrade the legacy software on one machine to the updated version on another
machine. Suppose, for example, that you have VirtualCenter 2.x on a 32-bit machine (source machine) and you
want vCenter Server to be on a 64-bit machine (destination machine).

VMware recommends that you back up your VirtualCenter database before you perform this procedure.

Prerequisites

The prerequisites for upgrading to vCenter Server include requirements for the vCenter Server system and
requirements for the database. See “Prerequisites for the vCenter Server Upgrade,” on page 38.

The database for the source machine can be local or remote, but it must be supported with vCenter Server 4.0.
If it is not supported, back it up and upgrade it to a supported database or import the tables into a supported
database. See “Database Scenarios,” on page 41.

If you are upgrading on a 64-bit system, see “Create a 32-Bit DSN on a 64-Bit Operating System,” on page 52.

Procedure

1 On the source machine, copy the SSL certificate folder at %ALLUSERSPROFILE%\Application
Data\VMware\VMware VirtualCenter.

2 Paste it on the destination machine.

n On Microsoft Windows 2003 Server: %ALLUSERSPROFILE%/Application Data/VMWare/VMware
VirtualCenter. Create the folder if it does not exist.

n On Microsoft Windows Vista and Microsoft Windows 2008 Server: %ALLUSERSPROFILE
%/VMWare/VMware VirtualCenter. Create the folder if it does not exist.

3 On the destination machine, configure a system DSN that points to the database.

The DSN must be 32-bit.
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4 On the source machine, stop the VirtualCenter service by selecting Start > Control Panel > Administrative
Tools > Services > VMware VirtualCenter Server.

5 On the destination machine, start the vCenter Server 4.0 installer.

6 When prompted by the installer, select the DSN that you configured on the destination machine.

The Database Upgrade wizard upgrades the database tables to make them compatible with vCenter
Server 4.0. If you are upgrading from VirtualCenter 2.0.x, you must complete the Database Upgrade
wizard. If you are upgrading from VirtualCenter 2.5, the Database Upgrade wizard runs in the
background.

The legacy VirtualCenter data is preserved and the database schema is upgraded to make it compatible with
vCenter Server 4.0. After the schema is upgraded, the database is not compatible with previous versions of
VirtualCenter.

What to do next

See Chapter 8, “Postupgrade Considerations for vCenter Server,” on page 55.
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Postupgrade Considerations for
vCenter Server 8

After you upgrade to vCenter Server, consider the postupgrade options and requirements.

n To view the upgrade log, open %TEMP%\VCDatabaseUpgrade.log.

n Install the vSphere Client and make sure you can access the vCenter Server instance.

n Upgrade any additional modules that are linked to this instance of vCenter Server. Additional modules
might include vCenter Update Manager, vCenter Converter, and vCenter Guided Consolidation, for
example.

n On the VMware Web site, log in to your account page to access the license portal. From the license portal,
upgrade your VirtualCenter 2.x license. Using the vSphere Client, assign the upgraded license key to the
vCenter Server 4.0 host.

n In the vSphere Client, select Home > vCenter Server Settings > Licensing to verify that the vCenter Server
is connected to a license server. A license server is required if this vCenter Server is managing ESX 3.x/ESXi
3.5 hosts. For information about installing the VMware License Server, see the documentation for VMware
Infrastructure 3.

n For Oracle databases, copy the Oracle JDBC Driver (ojdbc14.jar) driver to the[VMware vCenter
Server]\tomcat\lib folder.

n For SQL Server databases, if you enabled bulk logging for the upgrade, disable it after the upgrade is
complete.

n Optionally, join the vCenter Server system to a Linked Mode group.

n Optionally, upgrade the ESX/ESXi hosts in the vCenter Server inventory to ESX 4.0/ESXi 4.0.

n Optionally, enable SSL certification checking. Select Home > vCenter Server Settings > SSL Settings.
Select vCenter requires verified host SSL certificates and click OK. When you enable SSL checking, the
hosts become disconnected from vCenter Server, and you must reconnect them.

This chapter includes the following topics:

n “Upgrade to the vSphere Client,” on page 56

n “Using a License Server to Manage ESX 3.x/ESXi 3.5 Hosts,” on page 56

n “License Server Scenarios,” on page 57

n “Join a Linked Mode Group After a vCenter Server 4.0 Upgrade,” on page 57

n “Set the Maximum Number of Database Connections After a vCenter Server Upgrade,” on page 58

n “Restore VirtualCenter 2.x,” on page 59
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Upgrade to the vSphere Client
Virtual machine users and vCenter Server administrators must use the vSphere Client 4.0 to connect to vCenter
Server 4.0 or to connect directly to ESX 4.0 hosts.

The VI Client 2.5 and the vSphere Client 4.0 can be installed on the same machine.

The vSphere Client upgrade operation requires no downtime. No virtual machines or clients need to be
powered off for this process.

Procedure

1 (Optional) Use Add/Remove Programs from the Windows Control Panel to remove any previous vCenter
Server client.

Older vCenter Server clients do not need to be removed and are useful if you need to connect to legacy
hosts.

2 Install the vSphere Client 4.0.

If the vSphere Client installation fails, uninstall the vSphere Client using Add/Remove Programs from
the Windows Control Panel. Then reinstall the vSphere Client.

3 (Optional) Install vSphere Host Update Utility.

Install this utility if your environment does not use vCenter Update Manager and you want to use this
workstation to initiate upgrades of ESX 3.x/ESXi 3.5 hosts and manage ESXi host patching.

After you install the vSphere Client 4.0, you can connect to vCenter Server using the domain name or IP address
of the Windows machine on which vCenter Server is installed and the user name and password of a user on
that machine.

If you do not have the VI Client 2.5 installed and you use vSphere Client to connect to VirtualCenter 2.5, the
vSphere Client prompts you to download and install the VI Client 2.5. After you install the VI Client 2.5, you
can use the vSphere Client log-in interface to connect to VirtualCenter 2.5 or vCenter Server 4.0.

What to do next

Use the vSphere Client to connect to the vCenter Server IP address with your Windows login username and
password. Specifically, use the login credentials appropriate to the Windows machine on which vCenter Server
is installed. The vCenter Server username and password might be different than the username and password
you use for ESX/ESXi.

If the vSphere Client displays security alerts and exceptions when you log in or perform some operations, such
as opening performance charts or viewing the Summary tab, this might mean that your Internet Explorer (IE)
security settings are set to High. If your IE security settings are set to High, enable the Allow scripting of
Internet Explorer web browser control setting in IE.

If you cannot connect to the vCenter Server system, you might need to start the VMware VirtualCenter Server
service manually. To start the service, in the Settings menu, select Control Panel > Administrative Tools >
Services > VMware VirtualCenter Server. The machine might require several minutes to start the service.

Using a License Server to Manage ESX 3.x/ESXi 3.5 Hosts
vCenter Server 4.0 does not require a license server to manage ESX 4.0/ESXi 4.0 hosts. vCenter Server 4.0
requires a license server to manage ESX 3.x/ESXi 3.5 hosts.

If you do not have a license server installed and you need one, download the VMware License Server from the
VMware Web site.

The License Server installation requires no downtime. No virtual machines, servers, hosts, or clients need to
be powered off for the installation of the license server.
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License Server Scenarios
If you upgrade to vCenter Server 4.0 and you want the vCenter Server system to manage ESX 3.x/ESXi 3.5
hosts, you might need to verify that the license server is running and reconfigure vCenter Server 4.0 to point
to the license server, depending on your upgrade scenario.

Table 8-1 lists the license server scenarios and the necessary actions.

Table 8-1.  License Server Scenarios

Upgrade Scenario Necessary Action

In-place upgrade from VirtualCenter 2.x to vCenter Server. License server is on the same
machine.

None

In-place upgrade from VirtualCenter 2.x to vCenter Server. License server is on a different
machine.

None

Uninstall VirtualCenter 2.x. Preserve the license server. Perform a clean installation of
vCenter Server with a rebuilt, clean database.

Point vCenter Server to the
existing license server.

Uninstall VirtualCenter 2.x and the license server. Perform a clean installation of
vCenter Server with a rebuilt, clean database.

Install a new license server, and
point vCenter Server to the new
license server.

Clean installation of vCenter Server with a rebuilt, clean database. License server was on
a different machine.

Point vCenter Server to the
existing license server.

Upgrade to vCenter Server using a different machine. The VirtualCenter 2.x system is
the source machine. The vCenter Server 4.0 system is the destination machine.
See Chapter 7, “Upgrading to vCenter Server on a Different Machine and Keeping the
Existing Database,” on page 49.

Point vCenter Server to the
existing license server.

Join a Linked Mode Group After a vCenter Server 4.0 Upgrade
After you upgrade a machine to vCenter Server 4.0, you can join the system to a Linked Mode group.

Prerequisites

Before you join a Linked Mode group, review the Linked Mode prerequisites and considerations. See the
Installation Guide.

Procedure

1 From the Start menu, select All Programs > VMware > vCenter Server Linked Mode Configuration.

2 Click Next.

3 Select Modify linked mode configuration and click Next.

4 Click Join vCenter Server instance to an existing linked mode group or another instance and click
Next.

5 Enter the server name and LDAP port number of any remote vCenter Server that is or will be a member
of the group and click Next.

If you enter an IP address for the remote server, the installer converts it into a fully qualified domain name.

Chapter 8 Postupgrade Considerations for vCenter Server
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6 If the vCenter Server installer detects a role conflict, select how to resolve the conflict.

Option Description

Yes, let VMware vCenter Server
resolve the conflicts for me

Click Next.
The role on the joining system is renamed to <vcenter_name><role_name>
where <vcenter_name> is the name of the vCenter Server system that is joining
the Linked Mode group and <role_name> is the name of the original role.

No, I'll resolve the conflicts myself To resolve the conflicts manually:
a Using the vSphere Client, log in to the vCenter Server system that is

joining the Linked Mode group using an account with Administrator
privileges.

b Rename the conflicting role.
c Close the vSphere Client session and return to the vCenter Server

installer.
d Click Back, and click Next.
The installation continues without conflicts.

 
A conflict results if the joining system and the Linked Mode group each contain a role with the same name
but with different privileges.

7 Click Finish.

vCenter Server restarts. Depending on the size of your inventory, the change to Linked Mode might take
from a few seconds to a few minutes to complete.

The vCenter Server instance is now part of a Linked Mode group. It might take several seconds for the global
data (such as user roles) that are changed on one machine to be visible on the other machines. The delay is
usually 15 seconds or less. It might take a few minutes for a new vCenter Server instance to be recognized and
published by the existing instances, because group members do not read the global data very often.

After you form a Linked Mode group, you can log in to any single instance of vCenter Server and view and
manage the inventories of all the vCenter Servers in the group.

What to do next

For more information about Linked Mode groups, see Basic System Administration.

Set the Maximum Number of Database Connections After a vCenter
Server Upgrade

By default, a vCenter Server creates a maximum of 10 simultaneous database connections. If you configure
this setting in the previous version of vCenter Server and then perform the upgrade to vCenter Server 4.0, the
upgrade restores the default setting of 10. You can reconfigure the nondefault setting.

You do not need to change this value. You might want to increase this number if the vCenter Server frequently
performs many operations and performance is critical. You might want to decrease this number if the database
is shared and connections to the database are costly. VMware recommends that you not change this value
unless your system has one of these problems.

Perform this task before you configure the authentication for your database. For more information on
configuring authentication, see the documentation for your database.

Procedure

1 From a vSphere Client host that is connected to a vCenter Server system, select Administration > vCenter
Server Configuration and click Database.

2 In the Current vCenter Server menu, select the appropriate server.

3 In Maximum number, type the number.
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4 Restart the vCenter Server.

The new database setting takes effect.

Restore VirtualCenter 2.x
You can restore the previous VirtualCenter configuration if you have a full backup of your VirtualCenter
database and the previous VirtualCenter SSL certificates.

Prerequisites

You might need some or all of the following items to restore VirtualCenter and its components in the event of
a system failure or disaster. Follow your company disaster recovery guidelines for storage and handling of
these items.

n Installation media for the same version of VirtualCenter you are restoring

n VMware Infrastructure 3 license file or a running license server

n Database backup files

n SSL files found in: %ALLUSERSPROFILE%\Application Data\VMware\VMware VirtualCenter\SSL on the
VirtualCenter system

n Notes from the original installation regarding the selections, settings, and information used

n vpxd.cfg

n vCenter Server 4.0 and ESX 4.0/ESXi 4.0 license keys

Procedure

1 Completely uninstall vCenter Server 4.0.

2 Restore the previous version of the VirtualCenter database from the backup.

See your database documentation.

3 Reinstall your original version of VirtualCenter, selecting the restored database during the installation
process.

4 Verify that the license server is running if one was in use in the original installation.

5 Restore the VirtualCenter SSL certificate folder and vpxd.cfg to the %ALLUSERSPROFILE%\Application
Data\VMware\VMware VirtualCenter directory.

6 Make sure the system DSN points to the database.

Chapter 8 Postupgrade Considerations for vCenter Server
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Upgrading Datastore and Network
Permissions 9

In previous releases of vCenter Server, datastores and networks inherited access permissions from the
datacenter. In vCenter Server 4.0, they have their own set of privileges that control access to them. This might
require you to manually assign privileges, depending on the access level you require.

In vCenter 4.0, users are initially granted the No Access role on all new managed objects, including datastores
and networks. This means, by default, users cannot view or perform operations on them. All existing objects
in vCenter maintain their permissions after the upgrade. To determine whether to assign permissions to
existing datastores and networks, the upgrade process uses the datacenter's Read-only privilege.

n If the Read-only privilege is nonpropagating (not inherited by child objects), VMware assumes access
privileges should not be assigned to datastores and networks. In such cases, you must update your roles
to include the new datastore and network privileges desired. This is required for users to view and perform
operations on these objects.

n If the Read-only privilege is propagating (inherited by child objects), VMware assumes access privileges
should be assigned to datastores and networks so users can view them and perform basic operations that
require access. In such cases, the default minimum privileges are automatically assigned during the
upgrade process.

After the upgrade process, if your roles require users to have additional privileges, for example, the ability
to delete a datastore or network, you need to update your permission roles.

Table 9-1 lists the privileges assigned to datastores and networks before the upgrade to vCenter 4.0 and after
the upgrade to vCenter 4.0, and the action required by administrators to enable access.

Table 9-1.  Datastore and Network Permission Requirements

Object Before Upgrade Privilege After Upgrade Privilege Action Required to Enable Access

Datastore Nonpropagating Read-only No Access Assign access privileges for datastores or
datastore folders.

Propagating Read-only Allocate Space None.

Network Nonpropagating Read-only No Access Assign access privileges for networks or
network folders.

Propagating Read-only Assign Network None.

NOTE   The Read-only propagating permission on a datacenter, as well as all other permissions you have set,
will continue to work as expected after the upgrade.

This chapter includes the following topics:

n “Datastore Privileges,” on page 62

n “Network Privileges,” on page 62
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n “Update Datastore Permissions,” on page 63

n “Update Network Permissions,” on page 64

Datastore Privileges
In VMware vSphere 4.0, datastores have their own set of access control privileges. As a result, you might need
to reconfigure your permissions to grant the new datastore privileges. This is required if you have
nonpropagating Read-only permission set on the datacenter for users.

Table 9-2 lists the default datastore privileges that, when selected for a role, can be paired with a user and
assigned to a datastore.

Table 9-2.  Datastore Privileges

Privilege Name Actions Granted to Users Affects
Pair with
Object

Effective on
Object

Allocate Space Allocate space on a datastore for a virtual
machine, snapshot, or clone.

hosts, vCenter
Servers

datastores datastores,
virtual disks

Browse Datastore Browse files on a datastore, including CD-
ROM or Floppy media and serial or parallel
port files. In addition, the browse datastore
privilege allows users to add existing disks
to a datastore.

hosts, vCenter
Servers

datastores datastores,
datastore folders,
hosts, virtual
machines

Delete Datastore Remove a datastore. hosts, vCenter
Servers

datastores datastores,
datastore folders

Delete Datastore
File

Delete a file in the datastore. hosts, vCenter
Servers

datastores datastores

File Management Carry out file operations in the datastore
browser.

hosts, vCenter
Servers

datastores datastores

Move Datastore Move a datastore between folders in the
inventory.
NOTE   Privileges are required on both the
source and destination objects.

vCenter Servers datastore,
source and
destination
object

datastores,
datastore folders

Rename Datastore Rename a datastore. hosts, vCenter
Servers

datastores datastores

Network Privileges
In VMware vSphere 4.0, networks have their own set of access control privileges. As a result, you might need
to reconfigure your permissions to grant the new network privileges. This is required if you have
nonpropagating Read-only permission set on the datacenter.

Table 9-3 lists the default network privileges that, when selected for a role, can be paired with a user and
assigned to a network.

Table 9-3.  Network Privileges

Privilege Name Actions Granted to Users Affects
Pair with
Object

Effective on
Object

Assign Network Assign a network to a virtual
machine.

VCenter Servers virtual
machine

network, virtual
machine

Configure
Network

Configure a network. hosts, vCenter Servers network,
network
folder

networks, virtual
machines
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Table 9-3.  Network Privileges (Continued)

Privilege Name Actions Granted to Users Affects
Pair with
Object

Effective on
Object

Delete Network Remove a network. hosts, vCenter Servers datacenter datacenters

Move Network Move a network between folders in
the inventory.
NOTE   Privileges are required on both
the source and destination objects.

hosts, vCenter Servers network,
source and
destination

networks

Update Datastore Permissions
You must change Read-only nonpropagating datastore permissions to propagating datastore permissions in
order for users to access the datastores. You can assign datastore permissions on datastores or folders
containing datastores.

Prerequisites

Before performing the update procedure, determine which users need access to each datastore and which
privileges each user needs. If necessary, define new datastore roles or modify the Database Consumer sample
role. This sample role assigns the Allocate Space privilege to the datastore, which enables users to perform
basic virtual machine operations, such as creating clones and taking snapshots. In addition, organize your
datastores in folders that coincide with users' access needs.

NOTE   The Read-only propagating permission on a datacenter, in addition to all permissions you have set,
will be kept intact after the datastore permissions upgrade.

Procedure

1 Log in to vSphere Client as an administrator.

2 On the Home page, click Datastores to display the datastores in the inventory.

3 Select the datastore or datastore folder and click the Permissions tab.

4 Right-click in the Permissions tab and from the context pop-up menu, choose Add Permission.

5 In the Assigned Role pane, assign a role.

n To assign specific datastore privileges defined in a role by your company, choose the custom role.

n To migrate read-only nonpropagating datacenter permissions to propagating datastore permissions,
choose Datastore Consumer (sample). This role assigns the Allocate Space privilege to users, which
is required so that users can consume space on the datastores on which this role is granted. In order
to perform a space-consuming operation, such as creating a virtual disk or taking a snapshot, the user
must also have the appropriate virtual machine privileges granted for these operations.

n To assign Read-only datastore privileges, choose Read-only.

This role enables users to browse the datastore without giving them other datastore privileges. For
example, choose Read-only for users who need to attach CD/DVD-ROM ISO images to a datastore.

6 Select Propagate to Child Objects.

7 In the Users and Groups pane, click Add.

8 Select the users and groups for whom to add the role.

To select multiple names, control-click each additional name.

9 Click OK.

All users are added to the Users and Groups list for this role.
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10 Click OK.

The datastore is saved with the new permissions.

NOTE   You need to set up permissions for new datastores that you create. By default, new datastores are created
under the datacenter folder in the inventory. You can move it into a datastore folder, as appropriate.

Update Network Permissions
You must change Read-only nonpropagating network permissions to propagating network permissions in
order for users to access the networks. You can assign network permissions on networks or folders containing
networks.

Before performing the update procedure, determine the network organization for virtual machines, hosts, and
users. If necessary, define new networking roles or modify the Network Consumer sample role. This sample
role assigns the Assign Network privilege. In addition, group your networks in folders that coincide with your
organizational needs.

NOTE   The Read-only propagating permission on a datacenter, in addition to all permissions you have set,
will be kept intact after the network permissions upgrade.

Procedure

1 Log in to vSphere Client as an administrator.

2 On the Home page, click Networking to display the networks in the inventory.

3 Select the network or network folder and click the Permissions tab.

4 Right-click in the Permissions tab and from the context menu, choose Add Permission.

5 In the Assigned Role pane, do one of the following:

n To assign specific network privileges defined in a role by your company, choose the custom role.

NOTE   The Read-only propagating permission on a datacenter, in addition to all permissions you
have set, will be kept intact after the upgrade.

n To migrate read-only nonpropagating datacenter permissions to propagating network permissions,
choose Network Consumer (sample). This role assigns the Assign Networkprivilege to users, which
is required so that users can associate a virtual machine's vNIC or host's NIC with the network on
which this role is granted. This requires the appropriate permissions for the assignment are also
granted on the virtual machines or hosts.

6 Select Propagate to Child Objects.

7 In the Users and Groups pane, click Add.

8 Select the users and groups for whom to add the role.

To select multiple names, control-click each additional name.

9 Click OK.

All users are added to the Users and Groups list for this role.

10 Click OK.

New networks that you create are added under the datacenter by default.

NOTE   You need to set up permissions for new networks that you create. By default, new networks are created
under the datacenter folder in the inventory. You can move it into a network folder, as appropriate.
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Preparing for the Upgrade to ESX
4.0/ESXi 4.0 10

After completing the upgrade to vCenter Server, upgrade legacy VMware ESX/ESXi hosts to ESX 4.0/ESXi 4.0.

These topics are intended for administrators who are upgrading ESX, ESXi, and virtual machines from
ESX 3.x/ESXi 3.5 hosts to ESX 4.0/ESXi 4.0. One topic discusses the upgrade path from ESX 2.5.5.

This chapter includes the following topics:

n “About Host Upgrades,” on page 65

n “vSphere Host Update Utility,” on page 66

n “vCenter Update Manager,” on page 66

n “Recommendation for Static IP Addresses,” on page 67

n “List of Upgraded vSphere Components,” on page 67

n “List of Preserved Configuration Components,” on page 68

n “Back Up the ESX Host Configuration,” on page 69

n “Back Up the ESXi Host Configuration,” on page 69

n “Release Upgrade Support for ESX/ESXi,” on page 70

About Host Upgrades
To upgrade to vSphere 4.0, upgrade hosts with service consoles to ESX 4.0 (which also has a service console).
Upgrade hosts without service consoles to ESXi 4.0 (which does not have a service console). You cannot use
the upgrade tools to convert ESX hosts to ESXi hosts, or the reverse.

VMware provides the following tools for upgrading ESX/ESXi hosts:

vSphere Host Update
Utility

Graphical utility for standalone hosts. Allows you to perform remote upgrades
of ESX 3.x/ESXi 3.5 hosts to ESX 4.0/ESXi 4.0. vSphere Host Update Utility
upgrades the virtual machine kernel (vmkernel) and the service console, where
present. vSphere Host Update Utility does not upgrade VMFS datastores or
virtual machine guest operating systems.

vCenter Update Manager Robust software for upgrading, updating, and patching clustered hosts, virtual
machines, and guest operating systems. Orchestrates host and virtual machine
upgrades. If your site uses vCenter Server, VMware recommends that you use
VMware Update Manager instead of vSphere Host Update Utility. See the
vCenter Update Manager Administration Guide.
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vSphere Host Update Utility
When you install the vSphere Client, you can also install vSphere Host Update Utility. vSphere Host Update
Utility is a standalone Microsoft Windows application recommended for smaller deployments with fewer than
10 ESX/ESXi hosts, without vCenter Server or Update Manager.

vSphere Host Update Utility provides an easy way to upgrade from a remote location, without a CD, and with
minimum down time. The application upgrades the virtual machine kernel (vmkernel) and the service console,
where present. vSphere Host Update Utility does not upgrade VMFS datastores or virtual machine guest
operating systems.

You can use vSphere Host Update Utility to upgrade ESX 3.x to ESX 4.0 and ESXi 3.5 hosts to ESXi 4.0. You
cannot use vSphere Host Update Utility to convert ESX hosts to ESXi hosts, or the reverse.

When you select a host to be upgraded, the tool performs an automated host compatibility check as a
preupgrade step. The check verifies that each host is compatible with ESX 4.0/ESXi 4.0, including the required
CPU, and has adequate boot and root partition space. In addition to the automated preupgrade script, you can
specify a postupgrade configuration script to ease deployment. This tool effectively eliminates the need for
complex scripted upgrades.

The Host Upgrade wizard allows you to make upgrade configuration choices. Your choices are saved in an
installation script, which the software uploads to the selected host along with the installation ISO image.
vSphere Host Update Utility supports local or remote mounted ISO binary image files.

The software initiates the upgrade by rebooting the host and running the upgrade script. While an upgrade is
in progress, vSphere Host Update Utility provides visual status so that you can monitor the status of the
upgrade. If an error occurs during this process, the software rolls back the host software to the previous ESX
version.

In addition to performing upgrades, vSphere Host Update Utility lets you learn about, download, and install
maintenance and patch releases, which provide security, stability, and feature enhancements for ESXi 4.0.

System Requirements for vSphere Host Update Utility
vSphere Host Update Utility has the same system requirements as the vSphere Client.

To use vSphere Host Update Utility, you must have the following items:

n A workstation or laptop with vSphere Host Update Utility installed.

vSphere Host Update Utility is bundled with the vSphere Client. You can install vSphere Host Update
Utility when you install the vSphere Client. If the vSphere Client is already installed but vSphere Host
Update Utility is not installed, you can install an updated version by rerunning the vSphere Client installer.

n A network connection between the host and the computer that is running vSphere Host Update Utility.

vCenter Update Manager
Orchestrated upgrades allow you to upgrade the objects in your vSphere inventory in a two-step process: host
upgrades followed by virtual machine upgrades. You can configure the process at the cluster level for higher
automation or at the individual host or virtual machine level for granular control.

For example, you can define a host upgrade baseline to upgrade an ESX host to ESX 4.0, a virtual machine
upgrade baseline to upgrade the virtual machine hardware to the latest version, and the VMware Tools to the
latest version. To do this, you use wizard-based workflows to first schedule host upgrades for an entire cluster
and then schedule a virtual machine upgrade for all the virtual machines.

Built-in best practices in the wizard workflows preclude erroneous upgrade sequences. For example, the
wizard prevents you from upgrading virtual machine hardware before you upgrade hosts in a cluster.
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You can use Distributed Resource Scheduler (DRS) to prevent virtual machine downtime during the upgrade
process.

Update Manager monitors hosts and virtual machines for compliance against your defined upgrade baselines.
Noncompliance appears in detailed reports and in the dashboard view. Update Manager supports mass
remediation.

See the vCenter Update Manager Administration Guide.

Orchestrated Upgrade of Hosts Scenario
Update Manager allows you to perform orchestrated upgrades of the ESX/ESXi hosts in your vSphere inventory
using a single upgrade baseline.

You can perform orchestrated upgrades of hosts at the folder, cluster, or datacenter level.

Recommendation for Static IP Addresses
VMware recommends that you use static IP addresses for ESX/ESXi hosts. During host upgrade, static IP
addresses are a requirement.

DHCP IP addresses can be problematic during host upgrades. Suppose, for example, a host loses its DHCP IP
address during the upgrade because the lease period configured on the DHCP server expires. The host upgrade
tool that you are using (either vCenter Update Manager or vSphere Host Update Utility) would lose
connectivity to the host. The host upgrade might be successful, but the upgrade tool would report the upgrade
as failed, because the tool would be unable to connect to the host. To prevent this scenario, use static IP
addresses for your hosts.

List of Upgraded vSphere Components
vSphere Host Update Utility and Update Manager upgrade multiple VMware vSphere components.

Table 10-1 lists the components that each application upgrades. For components that are not upgraded by the
listed tool, you can perform the upgrade by some other method, generally by using the vSphere Client.

Table 10-1.  Upgraded Components

Component Upgraded by Update Manager Upgraded by vSphere Host Update Utility

Virtual machine kernel (vmkernel) Yes Yes

Service console, where present Yes Yes

Virtual machine hardware Yes No

Virtual Machine Tools Yes No

Guest operating systems Yes, for SP and patch releases No

After the upgrade to ESX 4.0, the service console's partitions are stored in a .vmdk file. These partitions
include /, swap, and all the optional partitions. The name of this file is esxconsole-<system-
uuid>/esxconsole.vmdk. All .vmdk files, including the esxconsole.vmdk, are stored in VMFS volumes.
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List of Preserved Configuration Components
When you upgrade to ESX 4.0/ESXi 4.0, the host upgrade process preserves many components of the ESX
3.x/ESXi 3.5 configuration.

ESXi
For ESXi, the upgrade to ESXi 4.0 preserves almost all configuration data, including your networking, security,
and storage configuration. The only configuration not preserved is related to licensing, because a new ESXi 4.0
license is required after the upgrade.

ESX
For ESX, the upgrade reuses the existing /boot partition to hold the ESX 4.0 boot files.

After the upgrade, the ESX 3.x installation is mounted in the new ESX 4.0 installation under the /esx3-
installation directory.

The upgrade to ESX 4.0 preserves almost all configuration data, including your networking, security, and
storage configuration. Specifically, the upgrade to ESX 4.0 preserves the following files from the ESX 3.x file
system.

n /etc/logrotate.conf

n /etc/localtime

n /etc/ntp.conf

n /etc/syslog.conf

n /etc/sysconfig/ntpd

n /etc/sysconfig/xinetd

n /etc/sysconfig/console

n /etc/sysconfig/i18n

n /etc/sysconfig/clock

n /etc/sysconfig/crond

n /etc/sysconfig/syslog

n /etc/sysconfig/keyboard

n /etc/sysconfig/mouse

n /etc/ssh

n /etc/nsswitch.conf

n /etc/yp.conf

n /etc/krb.conf

n /etc/krb.realms

n /etc/krb5.conf

n /etc/login.defs

n /etc/pam.d

n /etc/hosts.allow
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n /etc/hosts.deny

n /etc/ldap.conf

n /etc/openldap

n /etc/sudoers

n /etc/snmp

n /usr/local/etc

n /etc/rc.d/rc*.d/*

n /etc/xinetd.conf

n /etc/motd

n /etc/initiatorname.vmkiscsi

n /etc/vmkiscsi.conf

NOTE   To migrate other files, consider using a postupgrade script. For example, you might want to create a
script that copies the .ssh directory for root. The creation of custom scripts is beyond the scope of this manual.

Back Up the ESX Host Configuration
Before you upgrade an ESX host, back up the local VMFS file system. This ensures that you will not lose data
during the upgrade.

Procedure

n Back up the files in the /etc/passwd, /etc/groups, /etc/shadow, and /etc/gshadow directories.

The /etc/shadow and /etc/gshadow files might not be present on all installations.

n Back up any custom scripts.

n Back up your .vmx files.

n Back up local images, such as templates, exported virtual machines, and .iso files.

Back Up the ESXi Host Configuration
Back up the host configuration before you begin a host upgrade.

For more information about the VMware vSphere Command-Line Interface and the vicfg-cfgbackup
command, see the vSphere Command-Line Interface Installation and Reference Guide.

Procedure

1 Install the vSphere CLI.

2 In the vSphere CLI, run the vicfg-cfgbackup command with the -s flag to save the host configuration to
a specified backup filename.

 vicfg-cfgbackup --server <ESXi-host-ip> --portnumber <port_number> --protocol 

<protocol_type> --username username --password <password> -s <backup-filename>
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Release Upgrade Support for ESX/ESXi
If a VMware ESX/ESXi version does not have upgrade support, perform a clean installation, after you save
your VMFS datastore to another location or partition.

You can upgrade most versions of VMware ESX/ESXi to the ESX 4.0/ESXi 4.0 version. You cannot perform an
in-place upgrade from ESX to ESXi (or from ESXi to ESX). To upgrade virtual machines from ESX to ESXi (or
from ESXi to ESX), you must perform a migration upgrade.

Table 10-2 gives details of upgrade support for ESX and ESXi. Upgrade support for a version of ESX/ESXi
includes all associated update releases. For example, where upgrading from ESX 3.5 is supported, upgrades
from ESX 3.5 Update 1, ESX 3.5 Update 2, and so on are included.

Table 10-2.  Upgrade Support for ESX/ESXi

ESX Version Support

ESX alpha, beta, or RC release (any) No upgrade support

ESX 1.x No upgrade support

ESX 2 No upgrade support

ESX 2.1 No upgrade support

ESX 2.1.1 No upgrade support

ESX 2.1.2 No upgrade support

ESX 2.1.3 No upgrade support

ESX 2.5 No upgrade support

ESX 2.5.1 No upgrade support

ESX 2.5.2 No upgrade support

ESX 2.5.3 No upgrade support

ESX 2.5.4 No upgrade support

ESX 2.5.5 Limited support

ESX 3.0.0 Yes

ESX 3.0.1 Yes

ESX 3.0.2 Yes

ESX 3.0.3 Yes

ESX 3.5 Yes

ESXi 3.5 Yes

Upgrading from ESX 2.5.5
The only ESX 2.x version that has upgrade support is ESX 2.5.5, though support is limited for this type of
upgrade. VMware supports upgrades from ESX 2.5.5 under certain conditions.

When you upgrade from ESX 2.5.5 to ESX 4.0, you can perform a migration upgrade with or without VMotion.
In a migration upgrade, you migrate ESX 2.5.5 virtual machines to ESX 4.0 hosts, as follows: Evacuate the
virtual machines from the ESX 2.5.5 host. Do a fresh install of ESX 4.0. Migrate the virtual machines back to
the newly installed ESX 4.0 host. See “Upgrading by Moving Virtual Machines Using Upgrade VMotion,” on
page 20.
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Direct, in-place upgrade from ESX 2.5.5 to ESX 4.0 is not supported, even if you upgrade to ESX 3.x as an
intermediary step. The default ESX 2.5.5 installation creates a /boot partition that is too small to enable
upgrades to ESX 4.0. As an exception, if you have a non-default ESX 2.5.5 installation on which at least 100MB
of space is available on the /boot partition, you can upgrade ESX 2.5.5 to ESX 3.x and then to ESX 4.0.

The upgrade of ESX 2.5.5 to ESX 3.x requires the use of one of the following methods:

n Graphical upgrade from CD

n Text-mode upgrade from CD

n Tarball upgrade using the service console

n Scripted upgrade from CD or PXE server using esxupdate

n Scripted upgrade from CD or PXE server using kickstart commands

For information about these upgrade methods, see the VMware Infrastructure 3 documentation.

For the upgrade of ESX 3.x to ESX 4.0, you can use vSphere Host Update Utility or vCenter Update Manager.
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Upgrade to ESX 4.0 or ESXi 4.0 11
The upgrade procedures differ for ESX 4.0 and ESXi 4.0.

CAUTION  
n You must upgrade to vCenter Server before you upgrade ESX/ESXi. If you do not upgrade in the correct

order, you can lose data and lose access to your servers.

n When you upgrade a host from ESX 3.x to ESX 4.x, the customized partitions in 3.x are not replicated in
4.x.

This chapter includes the following topics:

n “Upgrade ESX Hosts,” on page 73

n “Upgrade ESXi Hosts,” on page 75

Upgrade ESX Hosts
You can use vSphere Host Update Utility to upgrade ESX 3.x hosts to ESX 4.0.

vSphere Host Update Utility is meant for small deployments in which a host is being managed by a single
administrator. For example, the following scenario is not supported: Admin 1 starts to upgrade host1 using
vSphere Host Update Utility. Admin 2 starts the vSphere Host Update Utility, detects that host1 is running
ESX 3.5, and tries to upgrade the host. The vSphere Host Update Utility does not report that an upgrade is
already in progress.

VMware supports and recommends that you perform one upgrade at a time when you use vSphere Host
Update Utility. If you do upgrade multiple hosts simultaneously and the upgrade fails for one of the hosts,
you must close and restart vSphere Host Update Utility to retry the upgrade on the host that failed. In this
case, you must wait until the upgrade for all the hosts is complete before you restart the utility. For simplicity,
it is best practice to upgrade one host at a time.

IMPORTANT   For large deployments and for environments with clustered hosts, VMware recommends that you
use vCenter Update Manager instead of vSphere Host Update Utility.

When you upgrade a host, no third-party management agents or third-party software applications are
migrated to the ESX 4.0/ESXi 4.0 host.

Prerequisites

Prepare the host before you upgrade it.

n See “ESX Hardware Requirements,” on page 27 and “Recommendations for Enhanced ESX
Performance,” on page 29.

n Make sure you are logged in to an account that has administrator permissions on your computer.
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Procedure

1 Download an ESX 4.0 ISO file and save it on the same Windows computer on which vSphere Host Update
Utility is installed.

2 Use the vSphere Client to put the host into maintenance mode.

3 Select Start > Programs > VMware > vSphere Host Update Utility 4.0.

4 Select a host from the list and click Upgrade.

If a host is not in the list, you can add it by selecting Host > Add Host.

5 Type the location of the ESX 4.0 installation file to use or click Browse to select the location from a file
browser and click Next.

For ESX 4.0, the installation file is an ISO image.

6 Select I accept the terms in the license agreement and click Next.

7 Type the administrative account information for the selected host and click Next.

The software performs a host compatibility check.

8 Select the datastore and size of the service console virtual disk (VMDK).

VMware recommends that you select a datastore that is local to the ESX host. The service console VMDK
requires at least 8.4GB of available space.

NFS and software iSCSI datastores are not supported as the destination for the ESX 4.0 service console
VMDK.

The service console must be installed on a VMFS datastore that is resident on a host's local disk or on a
SAN disk that is masked and zoned to that particular host only. The datastore cannot be shared between
hosts.

9 (Optional) To disable automatic rollback, deselect the Attempt to reboot host and roll back upgrade in
case of failure check box.

By default, if upgrade errors occur, the host reboots and rolls back the upgrade. If you disable this behavior,
you can troubleshoot the errors manually.

10 (Optional) To automate post-upgrade configuration, select Run a post-upgrade script and type the
location of a custom post-upgrade script, or click Browse to select the location from a file browser.

The upgrade installer supports the Bash (.sh) and Python (.py) interpreters.

11 (Optional) Select Roll back the upgrade if the post-upgrade script fails and select the number of seconds
(0 to 180 seconds) for the installer to wait before it rolls back the upgrade if the post-upgrade script fails.

By default, if the post-upgrade script fails, the host upgrade remains in effect.

12 Click Next.

13 Confirm your upgrade configuration and click Finish.

The host upgrade begins. You can view the upgrade progress in the Host Details pane.

The host is upgraded to ESX 4.0. If the upgrade fails, restart the vSphere Host Update Utility before you retry
the upgrade.

The vSphere Host Update Utility might appear to stop working. If this happens, wait several minutes to see
if the utility starts working again. VMware recommends that you do not cancel the upgrade at any point during
the upgrade process. The host might appear to successfully boot into ESX 4.0. If this happens, continue to wait
until the utility displays the message: Upgrade Succeeded before you close the utility.
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What to do next

See Chapter 12, “Postupgrade Considerations for Hosts,” on page 77.

Upgrade ESXi Hosts
You can use vSphere Host Update Utility to upgrade ESXi 3.5 hosts to ESXi 4.0.

vSphere Host Update Utility is meant for small deployments in which a host is being managed by a single
administrator. For example, the following scenario is not supported: Admin 1 starts to upgrade host1 using
vSphere Host Update Utility. Admin 2 starts the vSphere Host Update Utility, sees that host1 is running ESXi
3.5, and tries to upgrade the host. The vSphere Host Update Utility does not report that an upgrade is already
in progress.

VMware supports and recommends that you perform one upgrade at a time when you use vSphere Host
Update Utility. If you do upgrade multiple hosts simultaneously and the upgrade fails for one of the hosts,
you must close and restart vSphere Host Update Utility to retry the upgrade on the host that failed. In this
case, you must wait until the upgrade for all the hosts is complete before you restart the utility. For simplicity,
it is best practice to upgrade one host at a time.

IMPORTANT   For large deployments and for environments with clustered hosts, VMware recommends that you
use vCenter Update Manager instead of vSphere Host Update Utility.

When you upgrade a host, no third-party management agents or third-party software applications are
migrated to the ESX 4.0/ESXi 4.0 host.

Prerequisites

Prepare the host before you upgrade it.

n See “ESX Hardware Requirements,” on page 27 and “Recommendations for Enhanced ESX
Performance,” on page 29.

n Make sure you are logged in to an account that has administrator permissions on your computer.

Procedure

1 Download an ESXi 4.0 ZIP file and save it on the same Windows computer on which vSphere Host Update
Utility is installed.

2 Use the vSphere Client to put the host into maintenance mode.

3 Select Start > Programs > VMware > vSphere Host Update Utility 4.0.

4 Select a host from the list and click Upgrade.

If a host is not in the list, you can add it by selecting Host > Add Host.

5 Type the location of the ESXi 4.0 upgrade file to use or click Browse to select the location from a file browser
and click Next.

For ESXi 4.0, the installation file is a ZIP file.

6 Select I accept the terms in the license agreement and click Next.

7 Type the administrative account information for the selected host and click Next.

The software performs a host compatibility check.

8 Click Finish.

The host upgrade begins. You can view the upgrade progress in the Host Details pane.

When an upgrade is in progress, do not exit vSphere Host Update Utility.
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The host is upgraded to ESXi 4.0. If the upgrade fails, restart vSphere Host Update Utility before you retry the
upgrade.

vSphere Host Update Utility might appear to stop working. If this happens, wait several minutes to see if the
utility starts working again. VMware recommends that you do not cancel the upgrade at any point during the
upgrade process. The host might appear to successfully boot into ESXi 4.0. If this happens, continue to wait
until the message Upgrade Succeeded appears before you close the utility.

What to do next

See Chapter 12, “Postupgrade Considerations for Hosts,” on page 77.
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Postupgrade Considerations for
Hosts 12

A host upgrade is not entirely complete until after you have ensured that the host management, configuration,
and licensing is in place.

After you upgrade an ESX/ESXi host, consider the following:

n View the upgrade logs.

For ESXi, you can use the vSphere Client to export the log files.

For a successful ESX upgrade, you can find upgrade log files at these locations on the host:

n /esx3-installation/esx4-upgrade/

n /var/log/vmware/

For an unsuccessful ESX upgrade, you can find upgrade log files at these locations on the host:

n /esx4-upgrade/

n /var/log/vmware/

n If vCenter Server manages the host, you must reconnect the host to vCenter Server by right-clicking the
host in the vCenter Server inventory and selecting Connect.

n When the upgrade is complete, ESX/ESXi is in evaluation mode. Evaluation mode lasts for 60 days. You
must assign an upgraded license to your product within 60 days after the upgrade. Use the License Portal
and the vSphere Client to configure licensing.

n On the VMware Web site, log in to your account page to access the license portal. From the license portal,
upgrade your ESX/ESXi license. Use the vSphere Client to assign the upgraded license key to the ESX/ESXi
host.

n The host sdX devices might be renumbered after the upgrade. If necessary, update any scripts that
reference sdX devices.

n After the ESX/ESXi upgrade, you must convert LUN masking to the claim rule format. To do this, run the
esxcli corestorage claimrule convert command in the vSphere Command-Line Interface. This
command converts the /adv/Disk/MaskLUNs advanced configuration entry in esx.conf to claim rules with
MASK_PATH as the plug-in. See the vSphere Command-Line Interface Installation and Reference Guide.

This chapter includes the following topics:

n “Restore vSphere Web Access on ESX Hosts,” on page 78

n “Evaluation Period Countdown,” on page 78

n “Clean Up the ESX Bootloader Menu After Upgrade,” on page 79

n “Uninstalling the VMware License Server,” on page 79
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n “vSphere Host Update Utility Support for Rolling Back ESX/ESXi Upgrades,” on page 80

n “Roll Back an ESX Upgrade,” on page 80

n “Roll Back an ESXi Update, Patch, or Upgrade,” on page 81

n “Restore the ESX Host Configuration,” on page 81

n “Restore the ESXi Host Configuration,” on page 81

Restore vSphere Web Access on ESX Hosts
For ESX hosts only, the vSphere Web Access service is disabled after you upgrade the host. If you have Web
Access enabled on the host, you must restore the service after the upgrade is complete.

vSphere Web Access is a user interface that runs in a Web browser and provides access to the virtual machine’s
display. The vSphere Web Access service is installed when you install ESX 4.0 or vCenter Server 4.0, but is not
running by default. Before you log in and start managing virtual machines, you must start the vSphere Web
Access service on your ESX or vCenter Server instance.

NOTE   vSphere Web Access is not supported on ESXi hosts.

Prerequisites

You must have root privileges to check the status and run the vSphere Web Access service.

Procedure

1 Log in to the ESX host using root privileges.

2 Type the command to check whether the Web Access service is running.

service vmware-webAccess status

A message appears that says whether the service is running.

3 (Optional) If vSphere Web Access is not running, type the command to start Web Access.

service vmware-webAccess start

What to do next

You can now use vSphere Web Access to log in to the ESX host. See the vSphere Web Access Administrator's
Guide.

Evaluation Period Countdown
The ESX/ESXi 60-day evaluation period begins to count down immediately after the first time you power on
the ESX/ESXi machine.

The 60-day evaluation count down starts even if the host is licensed and you are not using evaluation mode.
For example, suppose you decide 10 days after the first power-on to switch from licensed mode to evaluation
mode. Only 50 days remain of the evaluation period. Sixty days after the first power-on, it is too late to switch
to evaluation mode because zero days remain of the evaluation period. During the evaluation period, if you
switch the ESX/ESXi machine from evaluation mode to licensed mode, the evaluation timer does not stop
counting down.

To prevent losing the availability of the evaluation mode, VMware recommends that before (or shortly after)
you power on your ESX/ESXi machine for the first time, decide whether you want to use evaluation mode.
One advantage of using evaluation mode is that it offers full feature functionality, which lets you try features
that you might not have yet without paying additional license costs.
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Clean Up the ESX Bootloader Menu After Upgrade
After you determine that the ESX 4.0 upgrade is stable, you can remove the ESX 3.x boot option from the ESX
4.0 bootloader menu to disable the ability to roll back to ESX 3.x.

After you upgrade a host from ESX 3.x to ESX 4.0, the ESX bootloader boots into ESX 4.0 by default, but retains
the option to boot into ESX 3.x. The ESX 3.x boot option is useful if the ESX 4.0 upgrade does not work as
expected in your environment. However, after you confirm that the upgrade is stable, you might want to
disable the ability to roll back to ESX 3.x.

This procedure is applicable only if you left the default rollback option enabled when you performed the
upgrade. If you deselected the rollback option, this procedure is not applicable. Only a system administrator
can perform this optional procedure.

Prerequisites

Before executing this script, make sure that you have copied all required data from the legacy ESX mount
points under /esx3-installation.

Procedure

1 In the ESX 4.0 service console, run the cleanup-esx3 command with the optional -f (force) flag.

If you omit the -f flag, the software prompts you to confirm that you want to disable the ability to roll
back to the ESX 3.x.

2 (Optional) Reboot the host.

While the server is powering on, observe that the bootloader menu does not include an option for ESX
3.x.

The host looks the same as a clean installation of ESX 4.0. The cleanup-esx3 script removes the following files
and references from the ESX 4.0 host:

n ESX 3.x references in the /etc/fstab directory

n ESX 3.x boot files in the /boot directory

n The rollback-to-esx3 script in the /usr/sbin/ directory

Uninstalling the VMware License Server
After you upgrade all of your hosts to ESX 4.0/ESXi 4.0, you can optionally uninstall your license server and
remove the license server configuration from vCenter Server.

NOTE   Consider leaving the license server and the license server configuration in place if the vCenter Server
instance might need to manage ESX 3.x/ESXi 3.5 hosts in the future. The license server does not interfere with
operations if you leave it in place.

Procedure

1 As Administrator on the Microsoft Windows system, select Start > Settings > Control Panel >
Add/Remove Programs.

2 Select the VMware License Server and click Remove.

3 Click Yes to confirm that you want to remove the program and click Finish.

4 In vCenter Server, select Administration > vCenter Server Settings.

5 In the License Server text box, delete the path to the license server.

6 If the Reconfigure ESX 3 hosts using license servers to use this server option is selected, unselect it.
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7 Click OK.

vSphere Host Update Utility Support for Rolling Back ESX/ESXi
Upgrades

When you use vSphere Host Update Utility to perform a host upgrade, the support for rolling back upgrades
differs for ESX and ESXi.

For ESX, the default behavior for vSphere Host Update Utility is to roll back the host to the previous version
of ESX if the upgrade does not complete successfully. You can override the default behavior by deselecting the
Attempt to reboot host and roll back upgrade in case of failure check box in the upgrade wizard. Disabling
the roll back allows you to debug your host if the installer fails.

For ESXi, vSphere Host Update Utility does not support roll back. However, after an upgrade, the ESXi host
might reboot into the previous version of the firmware if the upgrade version does not boot successfully. You
cannot disable this behavior. If the upgrade fails for VMware Tools or the vSphere Client, roll back is not
supported and the packages are removed from the host. The packages are removed because insufficient space
is available on ESXi for two versions of VMware Tools and two versions of the vSphere Client. vSphere Host
Update Utility must delete the previous versions before writing the new versions to disk.

After the roll back, upgrade to ESXi 3.5 Update 4 to obtain the latest version of ESXi 3.5 firmware, VMware
Tools and the VI Client.

Roll Back an ESX Upgrade
You might need to roll back to ESX 3.x if the upgrade to ESX 4.0 does not work as expected in your environment.
Optionally, you can remove the ESX 4.0 boot option from the ESX bootloader menu and perform a complete
roll back to ESX 3.x.

Consider the following points:

n Any changes made to the ESX 4.0 service console are lost after the rollback.

n Any changes made to virtual machines will persist after the rollback.

n If you upgraded the virtual machine hardware, the virtual machines will not work after you perform the
ESX rollback. To avoid this situation, take a snapshot of the virtual machine before you upgrade the virtual
machine hardware. After you run the ESX rollback script, boot into ESX 3.x and revert to the snapshot.

n Only a system administrator can perform this optional procedure.

Procedure

1 Run the rollback-to-esx3 command in the ESX 4.0 service console.

The rollback-to-esx3 command reconfigures the bootloader to boot into ESX 3.x and removes the ability
to boot into ESX 4.0.

You can include the optional -f (force) flag. If you omit the -f flag, you are prompted to confirm that you
want to roll back to ESX 3.x.

2 Reboot the server.

While the host is powering on, observe that the boot menu has changed to ESX 3.x.

3 After the host boots into ESX 3.x, delete the ESX 4.0 service console VMDK folder from the VMFS datastore.

The service console VMDK folder name has the following format: esxconsole-<UUID>.
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Roll Back an ESXi Update, Patch, or Upgrade
For purposes of rollback, the term update refers to all ESXi patches, updates, and upgrades. Each time you
update an ESXi host, a copy of the ESXi build is saved on your host. If you think an ESXi patch might be making
your host not work as expected in your environment, you can roll back the update.

ESXi permits only one level of rollback. Only one previous build can be saved at a time. In effect, each ESXi 4.0
host stores up to two builds, one boot build and one standby build.

When you manually boot into the standby build instead of the current boot build, an irreversible rollback
occurs. The standby build becomes the new boot build and remains the boot build until you perform another
update.

Procedure

1 Reboot the ESXi 4.0 host.

2 When the page that displays the current boot build appears, press Shift+r to select the standby build.

3 Press Shift+y to confirm the selection and press Enter.

The previous update rolls back. The standby build becomes the boot build.

Restore the ESX Host Configuration
If you backed up your ESX service console and VMFS files, you can restore your original ESX host configuration.

Procedure

1 Reinstall the original version of ESX on the host. See the Installation Guide.

2 Restore the backed-up service console and local VMFS files.

See http://www.vmware.com/resources/techresources/610.

Restore the ESXi Host Configuration
If you created a backup of the ESXi host configuration, you can restore the configuration.

To restore a configuration on a host, you must run the vSphere CLI virtual appliance from a remote host. When
you restore the configuration, the target host must be in maintenance mode, which means all virtual machines
(including the vSphere CLI virtual appliance) must be powered off.

For more information, see the ESXi and vCenter Server Setup Guide.

For more information about the VMware vSphere Command-Line Interface and the vicfg-cfgbackup
command, see the vSphere Command-Line Interface Installation and Reference Guide.

Procedure

1 Restore the ESXi software.

n Reinstall the ESXi Installable software by using the Installation CD.

n Recover the ESXi Embedded software by using the Recovery CD.

2 Install the vSphere CLI.

3 In the vSphere CLI, run the vicfg-cfgbackup command with the -l flag to load the host configuration
from a specified backup file.

Chapter 12 Postupgrade Considerations for Hosts

VMware, Inc.  81

http://www.vmware.com/resources/techresources/610


vSphere Upgrade Guide

82  VMware, Inc.



Upgrading Virtual Machines 13
After you perform an ESX/ESXi upgrade, VMware recommends that you upgrade all the virtual machines that
reside on the host.

The first step in upgrading virtual machines is to upgrade VMware Tools. If the virtual machines do not have
VMware Tools installed, you can use the VMware Tools upgrade procedure to install VMware Tools. After
you install or upgrade VMware Tools, upgrade the virtual machine hardware.

VMware offers the following tools for upgrading virtual machines:

vSphere Client Requires you to perform the virtual machine upgrade one step at a time.

vCenter Update Manager Automates the process of upgrading and patching virtual machines, thereby
ensuring that the steps occur in the correct order. You can use vCenter Update
Manager to directly upgrade virtual machine hardware, VMware Tools, and
virtual appliances. You can also patch and update third-party software running
on the virtual machines and virtual appliances. See the vCenter Update Manager
Administration Guide.

NOTE   Do not use vmware-vmupgrade.exe to upgrade virtual machines.

This chapter includes the following topics:

n “About VMware Tools,” on page 84

n “About Virtual Machines and ESX/ESXi Upgrades,” on page 84

n “Orchestrated Upgrade of Virtual Machines Scenario,” on page 84

n “Planning Downtime for Virtual Machines,” on page 85

n “Downtime for Upgrading Virtual Machines,” on page 85

n “Perform an Interactive Upgrade of VMware Tools on a Microsoft Windows Guest,” on page 86

n “Perform an Interactive Upgrade of VMware Tools on a Linux Guest in an X Terminal,” on page 87

n “Perform an Interactive Upgrade of VMware Tools on a Linux Guest with the RPM Installer,” on
page 88

n “Perform an Interactive Upgrade of VMware Tools on a Linux Guest with the Tar Installer,” on
page 89

n “Perform an Interactive Upgrade of VMware Tools on a Solaris Guest,” on page 91

n “Perform an Interactive Upgrade of VMware Tools in a Netware Virtual Machine,” on page 92

n “Perform an Automatic Upgrade of VMware Tools,” on page 93
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n “Upgrade VMware Tools on Multiple Virtual Machines,” on page 94

n “Configure a Virtual Machine to Automatically Upgrade VMware Tools,” on page 94

n “Upgrade Virtual Hardware,” on page 95

n “Upgrade Virtual Hardware on Multiple Virtual Machines,” on page 96

About VMware Tools
VMware Tools is a suite of utilities that enhances the performance of the virtual machine’s guest operating
system and improves management of the virtual machine.

Although the guest operating system can run without VMware Tools, you lose important functionality and
convenience. If you do not have VMware Tools installed in your virtual machine, you cannot use the shutdown
or restart options. You can use only the power options. Shut down the guest operating system from the virtual
machine console before you power off the virtual machine.

The installers for VMware Tools for Microsoft Windows, Linux, Solaris, and NetWare guest operating systems
are built into ESX/ESXi and VMware Server as ISO image files. An ISO image file looks like a CD-ROM to your
guest operating system and even appears as a CD-ROM disc in Microsoft Windows Explorer. You do not use
an actual CD-ROM disc to install VMware Tools, nor do you need to download the CD-ROM image or burn
a physical CD-ROM of this image file.

When you install VMware Tools, VMware vCenter Server temporarily connects the virtual machine’s first
virtual CD-ROM disk drive to the ISO image file that contains the VMware Tools installer for your guest
operating system. You are ready to begin the installation process.

When you upgrade VMware Tools, the software completely uninstalls and reinstalls the VMware Tools
package. For this reason, some functionality such as networking might temporarily stop working in the middle
of the upgrade procedure. The functionality is restored at the end of the upgrade procedure.

About Virtual Machines and ESX/ESXi Upgrades
Some virtual machines that you create on ESX 4.0/ESXi 4.0 hosts are supported on ESX 3.x/ESXi 3.5 hosts.

If you create a virtual machine on ESX 4.0/ESXi 4.0 and select the typical path, the virtual hardware version is
version 7. Virtual machines with virtual hardware version 7 are not supported on ESX 3.x/ESXi 3.5 hosts. When
you create virtual machines on ESX 4.0/ESXi 4.0, select the custom path and select virtual hardware version 4
to ensure that your virtual machines can run on ESX 3.x/ESXi 3.5 hosts. When the virtual machines have virtual
hardware version 4, you can migrate the virtual machines between the ESX 3.x/ESXi 3.5 and ESX 4.0/ESXi 4.0
hosts and use VMotion.

If you create virtual machines that use paravirtualization (VMI) or an enhanced networking device (vmxnet),
VMotion is not supported. In this case, you can move the virtual machine to the ESX 3.x host if the virtual
machine is powered off. Virtual machines that you create on ESX 4.0/ESXi 4.0 hosts are not supported on ESX 2.x
hosts.

Orchestrated Upgrade of Virtual Machines Scenario
An orchestrated upgrade allows you to upgrade VMware Tools and the virtual hardware of the virtual
machines in your vSphere inventory at the same time. You can perform an orchestrated upgrade of virtual
machines at the folder or datacenter level.

Update Manager makes the process of upgrading the virtual machines convenient by providing baseline
groups. When you remediate a virtual machine against a baseline group containing the
VMware Tools Upgrade to Match Host baseline and the VM Hardware Upgrade to Match Host baseline,
Update Manager sequences the upgrade operations in the correct order. As a result, the guest operating system
is in a consistent state at the end of the upgrade.
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Planning Downtime for Virtual Machines
Plan downtime for each virtual machine during the upgrade process. Typically, this downtime occurs during
the virtual machine upgrade and the VMware Tools upgrade. Depending on your upgrade plan, some virtual
machine downtime might be required during the ESX upgrade.

If an ESX/ESXi host is not managed by vCenter Server, you cannot use VMotion to move virtual machines. The
virtual machines must have some downtime when the ESX/ESXi host reboots after upgrade.

You might not have to shut down more than a single virtual machine at any given time. You can stagger virtual
machine downtimes to accommodate a schedule convenient to you and your customers.

For example:

n If your virtual machine users are located in diverse time zones, you can prepare by migrating virtual
machines to specific hosts to serve a given time zone. This way you can arrange host upgrades so that
virtual machine downtime occurs transparently outside business hours for that time zone.

n If your virtual machine users operate around the clock, you can delay downtime for their virtual machines
to normally scheduled maintenance periods. You do not need to upgrade any stage within a certain time
period. You can take as long as needed at any stage.

Downtime for Upgrading Virtual Machines
When you upgrade virtual machines, the required downtime varies depending on the guest operating system.

The following procedures are involved in upgrading virtual machines:

n Upgrade VMware Tools

n Upgrade virtual hardware

During the VMware Tools upgrade, the virtual machine remains powered on. For Microsoft Windows
operating systems, you must reboot the guest operating system at the end of the VMware Tools upgrade
procedure. For Linux, Netware, and Solaris guest operating systems, no reboot is required at the end of the
procedure.

When you upgrade VMware Tools, expect downtime as follows:

n No downtime is required for vCenter Server.

n No downtime is required for ESX/ESXi hosts.

n You must reboot the virtual machine at the end of the upgrade procedure, or later, to make the upgrade
take effect.

n On Windows guest operating systems, you must reboot the virtual machine a total of three times when
you upgrade VMware Tools and the virtual hardware:

a Power on the virtual machine.

b Upgrade VMware Tools.

c Reboot the virtual machine at the end of the VMware Tools upgrade.

d Power off the virtual machine.

e Upgrade the virtual Hardware.

f Power on the virtual machine.

g The Windows operating system detects new devices and prompts you to reboot the virtual machine.

h Reboot the virtual machine to make the devices work properly.

During the virtual hardware upgrade, the virtual machine must be shut down for all guest operating systems.
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Table 13-1 summarizes the downtime required by guest operating system and by upgrade operation.

Table 13-1.  Virtual Machine Downtime by Guest Operating System

Guest Operating System Upgrade VMware Tools Upgrade Virtual Hardware

Linux No downtime Downtime for shut down and power on of
virtual machine

Netware No downtime Downtime for shut down and power on of
virtual machine

Solaris No downtime Downtime for shut down and power on of
virtual machine

Microsoft Windows Downtime for reboot of guest
operating system

Downtime for shut down and power on of
virtual machine

Perform an Interactive Upgrade of VMware Tools on a Microsoft
Windows Guest

Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine’s guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See Basic System Administration.

n Make sure that a supported guest operating system is installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 If the Microsoft Windows New Hardware wizard appears in the virtual machine console, complete the
wizard and accept the defaults.

Upgrading virtual hardware and installing or upgrading VMware Tools includes enhancements to the
virtual network adapter. A Microsoft Windows guest operating system might interpret these changes as
indicating a different network adapter in the virtual machine and start the New Hardware wizard
accordingly.

7 In the virtual machine console, do one of the following:

n If autorun is enabled, click OK to confirm that you want to install VMware Tools and start the
InstallShield wizard.

n If autorun is not enabled, manually start the VMware Tools installer, by clicking Start > Run and
entering D:\setup.exe, where D: is your first virtual CD-ROM drive.
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8 Follow the onscreen instructions.

9 Reboot to make the changes take effect.

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Interactive Upgrade of VMware Tools on a Linux Guest in an
X Terminal

Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

The following items are prerequisites for completing this procedure:

n Back up your virtual machines to prevent data loss. See Basic System Administration.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

NOTE   This procedure requires the RPM installer. The RPM installer is not available for ESXi hosts. Only the
tar installer is available for ESXi hosts. For ESXi hosts, see “Perform an Interactive Upgrade of VMware Tools
on a Linux Guest with the Tar Installer,” on page 89.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 Start the installer.

n From the desktop, double-click the VMware Tools CD icon or the file manager window and double-
click the RPM installer.

n If the VMware Tools CD icon or file manager window does not appear, install VMware Tools from
the command line.

7 When prompted, enter the root password and click OK.

The installer prepares the packages.

8 In the Completed System Preparationdialog box, click Continue.

When the installer is finished, VMware Tools is installed. No confirmation or finish button appears.

9 In a terminal window, as root (su -), run the following command to configure VMware Tools:

vmware-config-tools.pl
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10 Answer the prompts and press Enter to accept the default values if appropriate for your configuration
and follow the instructions at the end of the script.

11 For Linux guest operating systems, execute the following commands to restore the network:

/etc/init.d/network stop

rmmod vmxnet

modprobe vmxnet

/etc/init.d/network start

12 Use the exit command to exit from the root account.

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Interactive Upgrade of VMware Tools on a Linux Guest with
the RPM Installer

Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See Basic System Administration.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

NOTE   The RPM installer is not available for ESXi hosts. Only the tar installer is available for ESXi hosts. For
ESXi hosts, see “Perform an Interactive Upgrade of VMware Tools on a Linux Guest with the Tar Installer,”
on page 89.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 In the virtual machine console, log in as root (su -) and, if necessary, create the /mnt/cdrom directory:

mkdir /mnt/cdrom

7 Mount the VMware Tools virtual CD-ROM image.

Some Linux distributions automatically mount CD-ROMs. If your distribution uses automounting, do not
use the mount and umount commands.
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Some Linux distributions use different device names or organize the /dev directory differently. Modify
the following commands to reflect the conventions used by your distribution:

mount /dev/cdrom /mnt/cdrom

cd /tmp

8 Change to a working directory (for example, /tmp):

cd /tmp

9 (Optional) If you have a previous installation, delete the previous vmware-tools-distrib directory:

rm -rf /tmp/vmware-tools-distrib

The default location of this directory is: /tmp/vmware-tools-distrib.

10 List the contents of the /mnt/cdrom/ directory and note the filename of the VMware Tools RPM installer:

ls /mnt/cdrom

11 Uncompress the rpm installer, where <xxxxxx> is the build or revision number of the ESX/ESXi version:

rpm -Uhv /mnt/cdrom/VMwareTools-4.0.0-<xxxxxx>.i386.rpm

If you attempt to install an RPM installation over a tar installation, or the reverse, the installer detects the
previous installation and must convert the installer database format before continuing.

12 Unmount the CD-ROM image:

umount /dev/cdrom

13 Double-click the RPM installer file and complete the installation.

14 Run the ./usr/bin/vmware-config-tools.pl script to configure tools.

15 Answer the prompts and press Enter to accept the default values if appropriate for your configuration
and follow the instructions at the end of the script.

16 For Linux guest operating systems, execute the following commands to restore the network:

/etc/init.d/network stop

rmmod vmxnet

modprobe vmxnet

/etc/init.d/network start

17 Log off the root account:

exit

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Interactive Upgrade of VMware Tools on a Linux Guest with
the Tar Installer

Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See Basic System Administration.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.
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Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 In the virtual machine console, log in as root (su -) and, if necessary, create the /mnt/cdrom directory:

mkdir /mnt/cdrom

7 Mount the VMware Tools virtual CD-ROM image.

Some Linux distributions automatically mount CD-ROMs. Verify the state by running the mount
command. If the CD-ROM device is mounted, each of the device's partitions with a recognized file system
appears in the output of the mount command as something like this:

/dev/cdrom on /mnt/cdrom type iso9660 (ro,nosuid,nodev)

If the CD-ROM device is listed, it is mounted. If the CD-ROM device is already mounted, do not use the
mount and umount commands.

Some Linux distributions use different device names or organize the /dev directory differently. Modify
the following commands to reflect the conventions used by your distribution:

mount /dev/cdrom /mnt/cdrom

8 Change to a working directory (for example, /tmp):

cd /tmp

9 If you have a previous installation, delete the previous vmware-tools-distrib directory:

rm -rf /tmp/vmware-tools-distrib

The default location of this directory is: /tmp/vmware-tools-distrib.

10 List the contents of the /mnt/cdrom/ directory, and note the filename of the VMware Tools tar installer:

ls /mnt/cdrom

11 Uncompress the tar installer, where <xxxxxx> is the build or revision number of the ESX/ESXi version.

tar zxpf /mnt/cdrom/VMwareTools-4.0.0-<xxxxxx>.tar.gz

If you attempt to install a tar installation over an RPM installation, or the reverse, the installer detects the
previous installation and must convert the installer database format before continuing.

12 Unmount the CD-ROM image:

umount /dev/cdrom

13 Run the VMware Tools tar installer:

cd vmware-tools-distrib

./vmware-install.pl
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14 Answer the prompts and press Enter to accept the default values if appropriate for your configuration
and follow the instructions at the end of the script.

15 For Linux guest operating systems, execute the following commands to restore the network:

/etc/init.d/network stop

rmmod vmxnet

modprobe vmxnet

/etc/init.d/network start

16 (Optional) When the upgrade is complete, log off the root account:

exit

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Interactive Upgrade of VMware Tools on a Solaris Guest
Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See Basic System Administration.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 In the virtual machine console, log in as root (su -) and, if necessary, mount the VMware Tools virtual
CD-ROM image, as follows.

Usually, the Solaris volume manager mounts the CD-ROM under /cdrom/vmwaretools. If the CD-ROM is
not mounted, restart the volume manager using the following commands:

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

7 After the CD-ROM is mounted, change to a working directory (for example, /tmp) and extract VMware
Tools:

cd /tmp

gunzip -c /cdrom/vmwaretools/vmware-solaris-tools.tar.gz | tar xf -
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8 Run the VMware Tools tar installer:

cd vmware-tools-distrib

./vmware-install.pl

Respond to the prompts and press Enter to accept the default values.

9 Log off of the root account:

exit

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Interactive Upgrade of VMware Tools in a Netware Virtual
Machine

Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See Basic System Administration.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 In the virtual machine console, load the CD-ROM driver so the CD-ROM device mounts the ISO image
as a volume.

7 Select Novell > Utilities > Server Console to open the Netware Server Console, and enter one of the
following commands:

n In the NetWare 6.5 Server Console, enter: LOAD CDDVD.

n In the NetWare 6.0 or NetWare 5.1 Server Console, enter: LOAD CD9660.NSS.

8 In the Server Console, enter the following command:

vmwtools:\setup.ncf

9 Check the VMware Tools label on the virtual machine Summary tab.

The VMware Tools label should say OK.
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When the installation finishes, the message VMware Tools for NetWare are now running appears in the Logger
Screen (NetWare 6.5 and NetWare 6.0 guests) or the Console Screen (NetWare 5.1 guests).

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Automatic Upgrade of VMware Tools
When you start an automatic upgrade of VMware Tools, you do not need to perform any operations in the
guest operating system that is running on the virtual machine. The automatic upgrade uninstalls the previous
version of VMware Tools, installs the latest version that is available for your ESX/ESXi host, and if necessary,
reboots the virtual machine.

Automatic VMware Tools upgrade is not supported for virtual machines with Solaris or Netware guest
operating systems.

Prerequisites

Make sure that you have the following items before you perform an automatic upgrade.

n A backup of your virtual machines to prevent data loss (see Basic System Administration)

n A supported guest operating system installed on the virtual machine

n An ESX/ESXi license or be using evaluation mode to power on the virtual machine

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

Wait until the guest operating system starts.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

If the guest operating system has an out-of-date version of VMware Tools, the Install/Upgrade Tools dialog
box appears.

5 Select Automatic Tools Upgrade.

6 (Optional) For Microsoft Windows guest operating systems only, specify a location for the log file by
entering values in the Advanced Options field.

For example, /s /v "/qn" /l "<Microsoft Windows_location\filename.log>" performs a silent upgrade
of VMware Tools and creates a log file in the specified location on the guest operating system.

7 (Optional) For Linux guest operating systems only, you can enter values in the Advanced Options field.

Option Description

--default Same as the default behavior. Performs a silent upgrade of VMware Tools.
Installs tools bin, lib and doc files in the default /usr directory.

--
prefix=<binary_location>,<lib_l
ocation>,<doc_location>

Performs a silent upgrade of VMware Tools and installs the binary, library,
and document files in the specified locations.
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8 Click OK.

9 For Linux guest operating systems, run the following commands to restore the network.

/etc/init.d/network stop

rmmod vmxnet

modprobe vmxnet

/etc/init.d/network start

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Upgrade VMware Tools on Multiple Virtual Machines
You can upgrade VMware Tools on multiple virtual machines by using the Virtual Machines tab.

Prerequisites

Create backups or snapshots of the virtual machines. See Basic System Administration.

Procedure

1 Start the vSphere Client and log in to the vCenter Server.

2 Select Inventory > Hosts and Clusters.

3 Select the host or cluster that contains the virtual machines to upgrade.

4 Click the Virtual Machines tab.

5 Select the virtual machines to upgrade and power them on.

6 Right-click your selections, select Install/Upgrade Tools and click OK.

7 For Linux guest operating systems, execute the following commands to restore the network:

/etc/init.d/network stop

rmmod vmxnet

modprobe vmxnet

/etc/init.d/network start

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7. See “Upgrade Virtual Hardware on
Multiple Virtual Machines,” on page 96.

Configure a Virtual Machine to Automatically Upgrade VMware Tools
You can configure a virtual machine to check for and apply VMware Tools upgrades each time you power on
the virtual machine.

Automatic VMware Tools upgrade is not supported for virtual machines with Solaris or Netware guest
operating systems.

Prerequisites

n Back up your virtual machines to prevent data loss. See Basic System Administration.

n Virtual machines must have a version of VMware Tools shipped with ESX 3.0.1 or later installed.
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n Virtual machines must be hosted on an ESX 3.0.1 or later, and VirtualCenter must be version 2.0.1 or later.
Virtual machines residing on a VMware Server host cannot be automatically upgraded.

n Virtual machines must be running a Linux or Microsoft Windows guest operating system that is supported
by ESX 3.0.1 or later and VirtualCenter 2.0.1 or later.

Procedure

1 Power off the virtual machine.

2 Right-click the virtual machine and select Edit Settings.

3 On the Options tab, select VMware Tools.

4 In the Advanced pane, select Check and upgrade Tools before each power-on and click OK.

The next time you power on the virtual machine, it checks the ESX/ESXi host for a newer version of VMware
Tools. If a newer version is available, it is installed and the guest operating system is restarted (if required).

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Upgrade Virtual Hardware
You can upgrade the hardware version of virtual machines to the latest version of ESX/ESXi. For virtual
machines that are running on ESX 4.0/ESXi 4.0, VMware recommends that you upgrade the virtual hardware
to version 7.

Consider the following points:

n When you upgrade from virtual hardware version 3 to version 7, the upgrade is irreversible, even if you
take a virtual machine backup or snapshot before performing the upgrade. When you upgrade from virtual
hardware version 4 to version 7 the upgrade is reversible if you take a virtual machine backup or snapshot
before performing the upgrade.

n Upgraded virtual machines cannot be powered on by an ESX 2.x host, even if relocated to a VMFS2
datastore.

n To automate this process, consider using vCenter Update Manager for virtual machine upgrades. vCenter
Update Manager performs automatic backups before performing virtual machine upgrades. See the
vCenter Update Manager Administration Guide.

n When you upgrade virtual hardware, no downtime is required for vCenter Server or ESX/ESXi hosts. For
virtual machines, the only significant downtime is the time to reboot the guest operating systems.

Prerequisites

n Create a backup or snapshot of the virtual machine. See Basic System Administration.

n Upgrade VMware Tools.

n Make sure that all .vmdk files are available to the ESX/ESXi host on a VMFS3 datastore.

n Make sure that the virtual machine is stored on VMFS3 or NFS datastores.

n Make sure that no suspend files exist.

n Make sure that at least one virtual disk exists.
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n Determine the version of the virtual hardware by selecting the virtual machine and clicking the
Summary tab. The VM Version label displays the virtual hardware version.

IMPORTANT   VMware recommends that before you upgrade the virtual hardware, first upgrade VMware Tools
on the virtual machine. This is especially important for virtual machines with Microsoft Windows guest
operating systems. On Microsoft Windows virtual machines, if you upgrade the virtual hardware before you
upgrade VMware Tools, the virtual machine might lose its network settings.

To automate this process, consider using vCenter Update Manager for virtual machine upgrades. vCenter
Update Manager ensures that upgrade procedures happen in the correct order. See the vCenter Update Manager
Administration Guide.

Procedure

1 Power off the virtual machine.

2 From the vSphere Client, right-click a virtual machine in the inventory and select Upgrade Virtual
Hardware.

The software upgrades the virtual hardware to the latest supported version.

The Upgrade Virtual Hardware option appears if the virtual hardware on the virtual machine is not the
latest supported version.

3 Click Yes to continue with the virtual hardware upgrade.

4 Power on the virtual machine.

If the virtual machine has a Microsoft Windows guest operating system, the operating system detects a
new device, configures the device, and prompts you to reboot the guest operating system. If any unknown
devices are recognized, the operating system prompts you to configure the device manually.

5 For Windows guest operating systems, reboot the guest operating system to make the changes take effect.

The virtual hardware version is 7 on the VM Version label on the virtual machine Summary tab.

Upgrade Virtual Hardware on Multiple Virtual Machines
You can upgrade virtual hardware on multiple virtual machines by using the Virtual Machines tab.

Prerequisites

n Create backups or snapshots of the virtual machines. See Basic System Administration.

n Upgrade VMware Tools.

n Make sure that all .vmdk files are available to the ESX/ESXi host on a VMFS3 datastore.

n Make sure that the virtual machines are stored on VMFS3 or NFS datastores.

n Make sure that no suspend files exist.

n Make sure that at least one virtual disk exists for each virtual machine.

Procedure

1 Start the vSphere Client and log in to the vCenter Server.

2 Select Inventory > Hosts and Clusters.

3 Select the host or cluster that contains the virtual machines to upgrade.

4 Click the Virtual Machines tab.

5 Select the virtual machines to upgrade and power them off.

6 Right-click your selections, select Upgrade Virtual Hardware and click Yes.
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7 Power on the virtual machines.

For Microsoft Windows guest operating systems, the operating system detects a new device, configures
the device, and prompts you to reboot the guest operating system. If any unknown devices are recognized,
the operating system prompts you to configure the device manually.

8 For Windows guest operating systems, reboot the guest operating system to make the changes take effect.

The virtual hardware version is 7 on the VM Version label on the virtual machine Summary tab.
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About Host Updates and Patches 14
Host updates are for maintenance releases. Software patches address critical security issues or urgent bug fixes.
An update or patch can include a new build of firmware, an update of VMware Tools, or an update of the
vSphere Client.

VMware provides the following tools for installing updates and patches to ESX/ESXi hosts:

vSphere Host Update
Utility

Graphical utility for ESXi only.

vCenter Update Manager For ESX and ESXi, automates patching and updates. See the vCenter Update
Manager Administration Guide.

vihostupdate Command-line utility for ESX and ESXi.

esxupdate Command-line utility for ESX only. See the Patch Management Guide.

This chapter includes the following topics:

n “Best Practices for Updates,” on page 99

n “About Patching Hosts with vSphere Host Update Utility,” on page 99

n “About the vihostupdate Command-Line Utility,” on page 102

Best Practices for Updates
Follow best practices when you install updates on hosts.

n After each update, test the system to ensure that the update was completed successfully.

n If the installation was unsuccessful, revert to the last good known image. See “Roll Back an ESXi Update,
Patch, or Upgrade,” on page 81 and “Uninstall a Bundle from a Host,” on page 104.

About Patching Hosts with vSphere Host Update Utility
With vSphere Host Update Utility, you can download and install maintenance and patch releases, which
provide security, stability, and feature enhancements for ESXi hosts.

You can use vSphere Host Update Utility to check for new release updates and patches that are applicable to
the ESXi hosts registered in the vSphere Host Update Utility. vSphere Host Update Utility builds the host list
by tracking the hosts that you connect to directly through the vSphere Client. You can also add hosts to the
list manually.
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System Requirements for vSphere Host Update Utility
vSphere Host Update Utility has the same system requirements as the vSphere Client.

To use vSphere Host Update Utility, you must have the following items:

n A workstation or laptop with vSphere Host Update Utility installed.

vSphere Host Update Utility is bundled with the vSphere Client. You can install vSphere Host Update
Utility when you install the vSphere Client. If the vSphere Client is already installed but vSphere Host
Update Utility is not installed, you can install an updated version by rerunning the vSphere Client installer.

n A network connection between the host and the computer that is running vSphere Host Update Utility.

Add a Host to the List
vSphere Host Update Utility compiles a list of ESX/ESXi hosts that you connect to directly by using the vSphere
Client. If the list is not complete, you can add hosts to be managed by vSphere Host Update Utility.

Prerequisites

The host must be reachable.

Procedure

1 Select Start > Programs > VMware > vSphere Host Update Utility 4.0.

2 Select Host > Add Host.

3 Enter the host name or IP address and click Add.

vSphere Host Update Utility verifies that the selected host is reachable and adds the host to the list.

What to do next

Scan hosts and apply available updates or upgrade a host.

Download Patches and Updates
For ESXi, you can download available host patches and maintenance updates.

Procedure

1 Select Start > Programs > VMware > vSphere Host Update Utility 4.0.

2 Select File > Download Patches from VMware.

vSphere Host Update Utility downloads patches and updates from the official servers.

What to do next

Scan the hosts and apply the updates and patches.

Scan Hosts and Apply Available Updates and Patches
You can check whether updates are available for the reachable hosts in your datacenter.

When you select a patch to install, consider the following points:

n The patch might be part of a bulletin that includes multiple patches.

n The contents of bulletins might overlap with each other.

n The patch might depend on other patches as prerequisites.
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n One patch might be a subset of another patch.

These behaviors are expected and are managed by vSphere Host Update Utility as needed. If you install a
patch, do not be concerned if vSphere Host Update Utility installs multiple patches.

Procedure

1 Select Start > Programs > VMware > vSphere Host Update Utility 4.0.

2 Select a host.

3 In the Host Details pane, click Scan for Patches.

4 Enter the host username and password and click Login.

5 (Optional) If updates are available, click Patch Host.

For each host that you scan, vSphere Host Update Utility downloads available updates to the host. After
the host is updated, an OK button appears.

6 Click OK.

After all updates are applied, vSphere Host Update Utility restarts the updated services.

What to do next

If you have multiple hosts, repeat this procedure until all hosts are updated.

Customizing vSphere Host Update Utility
If the default settings for vSphere Host Update Utility do not meet the needs of your environment, you can
customize the application.

Customize the application by modifying the settings.config XML file, located in the application folder. If
you installed the vSphere Client at the default location, the settings.config XML file is located at one of the
following locations:

n 32-bit OS: %PROGRAMFILES%\VMware\Infrastructure\VIUpdate 4.0

n 64-bit OS: %PROGRAMFILES(X86)%\VMware\Infrastructure\VIUpdate 4.0

You can make the following customizations in the settings.config file:

RemoteDepot URL of the remote server to retrieve host patches and updates.

LocalDepot Local path on your machine where host patches and updates are stored.

ProxyServer Proxy server to use for downloads. By default, this element is empty. In regard
to proxy servers, vSphere Host Update Utility does not support authenticated
proxies.

UserSettingsDirectory Directory where user settings are stored.

AskBeforeDownload Display a confirmation prompt to download patches from the VMware patch
repository. Can be True or False. By default, the value is set to True.

About ESXi Boot and Standby Builds
ESXi hosts can store a boot build and a standby build.

For each update, the update utility updates the standby build. After the update, you then reboot the host. After
the host reboots, the standby build becomes the boot build, and the previous boot build becomes the standby
build. If the update is successful, the host continues to boot from the new boot build until the next update.
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For example, suppose the current boot build is 52252 and the current standby build is 51605. When you update
the host to build 52386, the update process replaces build 51605 with build 52386 and makes build 52252 the
standby build. If the update is successful, you continue to boot from build 52386 until the next update.

If an update fails and the ESXi 4.0 host cannot boot from the new build, the host reverts to booting from the
original boot build.

Roll Back an ESXi Update, Patch, or Upgrade
For purposes of rollback, the term update refers to all ESXi patches, updates, and upgrades. Each time you
update an ESXi host, a copy of the ESXi build is saved on your host. If you think an ESXi patch might be making
your host not work as expected in your environment, you can roll back the update.

ESXi permits only one level of rollback. Only one previous build can be saved at a time. In effect, each ESXi 4.0
host stores up to two builds, one boot build and one standby build.

When you manually boot into the standby build instead of the current boot build, an irreversible rollback
occurs. The standby build becomes the new boot build and remains the boot build until you perform another
update.

Procedure

1 Reboot the ESXi 4.0 host.

2 When the page that displays the current boot build appears, press Shift+r to select the standby build.

3 Press Shift+y to confirm the selection and press Enter.

The previous update rolls back. The standby build becomes the boot build.

About the vihostupdate Command-Line Utility
The vihostupdate command applies software updates to ESX/ESXi hosts and installs and updates ESX/ESXi
extensions such as VMkernel modules, drivers, and CIM providers.

IMPORTANT   Run vihostupdate on ESX 4.0/ESXi 4.0 hosts. Run vihostupdate35 on ESX 3.5/ESXi 3.5 hosts.

NOTE   The esxupdate utility is supported as well. It is for ESX only. See the Patch Management Guide.

The vihostupdate command works with bulletins. Each bulletin consists of one or more vSphere bundles and
addresses one or more issues.

Towards the end of a release, bulletins include a large number of other bulletins. Bulletins are available in
offline bundles and in a depot with associated metadata.zip files.

n If you use offline bundles, all patches and corresponding metadata are available as one ZIP file.

n If you use a depot, the metadata.zip file points to metadata, which describes the location of the files.

The command supports querying installed software on a host, listing software in a patch, scanning for bulletins
that apply to a host, and installing all or some bulletins in the patch. You can specify a patch by using a bundle
ZIP file or a depot’s metadata ZIP file.

vihostupdate supports https://, http://, and ftp:// downloads. You can specify the protocols in the
download URL for the bundle or metadata file. vihostupdate also supports local paths. See “Update an
ESX/ESXi Host Using Offline Bundles with the vihostupdate Utility,” on page 103. To search a local depot
where the vSphere CLI is installed, use /local/depot/metadata.zip without of the file:/// parameter.
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Update an ESX/ESXi Host Using Offline Bundles with the vihostupdate Utility
You can use the vihostupdate utility in conjunction with offline bundles or with a depot. This topic describes
the procedure using offline bundles.

Prerequisites

Before you can update or patch an ESX/ESXi host from the command line, you must have access to a machine
on which you can run the VMware vSphere Command-Line Interface (vSphere CLI). You can install the
vSphere CLI on your Microsoft Windows or Linux system or import the VMware vSphere Management
Assistant (vMA) virtual appliance onto your ESX/ESXi host. For information about importing or installing the
vSphere CLI, see the VMware vSphere Command-Line Interface Installation and Reference Guide.

Procedure

1 Power off any virtual machines that are running on the host and place the host into maintenance mode.

2 Find out which bulletins are applicable to the ESX/ESXi host.

n Search an offline HTTP server:

vihostupdate.pl --server <server> --scan --bundle http://<webserver>/rollup.zip

n Search the local machine:

vihostupdate.pl --server <server> --scan --bundle <local_path>/rollup.zip

The --server argument is the ESX/ESXi host name or IP address.

Do not specify more than one bundle ZIP file at the command line each time you run the command. If you
specify --bundle more than once, the command processes only the last file that was specified.

3 (Optional) List all the bulletins that are available in the bundle.

n Search an offline HTTP server:

vihostupdate.pl --server <server> --list --bundle http://<webserver>/rollup.zip

n Search the local machine:

vihostupdate.pl --server <server> --list --bundle <local_path>/rollup.zip

This command lists all the bulletins contained in the bundle, even those that do not apply to the host.

4 Install bulletins from the bundle on the ESX/ESXi host.

n Install from an offline HTTP server:

vihostupdate.pl --server <server> --install --bundle http://<webserver>/rollup.zip --

bulletin bulletin1,bulletin2

n Install from the local machine:

vihostupdate.pl --server <server> --install --bundle <local_path>/rollup.zip --bulletin 

bulletin1,bulletin2

If you omit the --bulletin argument, this command installs all the bulletins in the bundle.

5 Verify that the bulletins are installed on your ESX/ESXi host.

vihostupdate.pl --server <server> --query

6 (Optional) Remove individual bulletins.

vihostupdate.pl --server <server> --remove --bulletin bulletin1

Use this option only for removing bulletins that are third-party or VMware extensions. Do not remove
bulletins that are VMware patches or updates. vihostupdate can remove only one bulletin at a time.
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Update an ESX/ESXi Host Using a Depot with the vihostupdate Utility
You can use the vihostupdate utility in conjunction with bundles or with a depot. This topic describe the
procedure using depots.

Prerequisites

Before you can update or patch an ESX/ESXi host from the command line, you must have access to a machine
on which you can run the VMware vSphere Command-Line Interface (vSphere CLI). You can install the
vSphere CLI on your Microsoft Windows or Linux system or import the VMware vSphere Management
Assistant (vMA) virtual appliance onto your ESX/ESXi host. For information about importing or installing the
vSphere CLI, see the VMware vSphere Command-Line Interface Installation and Reference Guide.

Procedure

1 Power off any virtual machines that are running on the host and place the host into maintenance mode.

2 Scan the depot for bulletins that are applicable to the host:

vihostupdate.pl --server <server> --scan --metadata http://<webserver>/depot/metadata.zip

The --server argument is the ESX/ESXi host name or IP address.

Do not specify more than one ZIP file at the command line each time you run the command. If you specify
--metadata more than once, the command processes only the last file that was specified.

3 (Optional) List all bulletins in the depot at the metadata.zip file location:

vihostupdate.pl --list --metadata http://<webserver>/depot/metadata.zip

This command lists all the bulletins in the depot, even those that do not apply to the host.

4 Install bulletins in the depot on the host:

vihostupdate.pl --install --metadata http://<webserver>/depot/metadata.zip --bulletin 

bulletin1,bulletin2

If you omit the --bulletin argument, this command installs all the bulletins in the bundle.

5 Verify that the bulletins are installed on your ESX/ESXi host.

vihostupdate.pl --server <server> --query

6 (Optional) Remove individual bulletins.

vihostupdate.pl --server <server> --remove --bulletin bulletin1

Use this option only for removing bulletins that are third-party or VMware extensions. Do not remove
bulletins that are VMware patches or updates. vihostupdate can remove only one bulletin at a time.

Uninstall a Bundle from a Host
Use this procedure to uninstall bulletins that are third-party or VMware extensions.

Do not remove bulletins that are VMware patches or updates.

Prerequisites

Before you can uninstall an update or patch from an ESX/ESXi host from the command line, you must have
access to a machine on which you can run the VMware vSphere Command-Line Interface (vSphere CLI). You
can install the vSphere CLI on your Microsoft Windows or Linux system or import the VMware vSphere
Management Assistant (vMA) virtual appliance onto your ESX/ESXi host. For information about deploying or
installing the vSphere CLI, see the VMware vSphere Command-Line Interface Installation and Reference Guide.
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Procedure

1 Determine which bulletins are installed on your ESX/ESXi host.

vihostupdate.pl --server <server> --query

Note the bundle ID for the bundle to uninstall.

2 Run the vihostupdate command.

vihostupdate --server <server> --remove --bulletin <bulletin ID>

vihostupdate can remove only one bulletin at a time.

Chapter 14 About Host Updates and Patches
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